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What We’ll Do ...

• Underlying ideas, methods, and issues in 
simulation

• Software-independent (setting up for Arena)
• Centered around an example of a simple 

processing system
▪ Decompose the problem
▪ Terminology
▪ Simulation by hand
▪ Some basic statistical issues
▪ Overview of a simulation study



Chapter 2 – Fundamental Simulation Concepts Slide 3 of 46Simulation with Arena, 3rd ed.

The System:
A Simple Processing System

Arriving
Blank Parts

Departing
Finished Parts

Machine
(Server)

Queue (FIFO) Part in Service

4567

• General intent:
▪ Estimate expected production
▪ Waiting time in queue, queue length, proportion of time 

machine is busy
• Time units

▪ Can use different units in different places … must declare
▪ Be careful to check the units when specifying inputs
▪ Declare base time units for internal calculations, outputs
▪ Be reasonable (interpretation, roundoff error)
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Model Specifics
• Initially (time 0) empty and idle
• Base time units:  minutes
• Input data (assume given for now …), in minutes:
 Part Number Arrival Time Interarrival Time Service Time
  1 0.00 1.73 2.90
  2 1.73 1.35 1.76
  3 3.08 0.71 3.39
  4 3.79 0.62 4.52
  5 4.41 14.28 4.46
  6 18.69 0.70 4.36
  7 19.39 15.52 2.07
  8 34.91 3.15 3.36
  9 38.06 1.76 2.37
  10 39.82 1.00 5.38
  11  40.82 . .
  . . . .
  . . . .

• Stop when 20 minutes of (simulated) time have 
passed
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Goals of the Study:
Output Performance Measures

• Total production of parts over the run (P)
• Average waiting time of parts in queue:

• Maximum waiting time of parts in queue:

N = no. of parts completing queue wait
WQi = waiting time in queue of ith part
Know:  WQ1 = 0 (why?)
     N > 1 (why?)N
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Goals of the Study:
Output Performance Measures (cont’d.)

• Time-average number of parts in queue:

• Maximum number of parts in queue:
• Average and maximum total time in system of 

parts (a.k.a. cycle time):

Q(t) = number of parts in queue
  at time t20
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Goals of the Study:
Output Performance Measures (cont’d.)

• Utilization of the machine (proportion of time 
busy)

• Many others possible (information overload?)
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Analysis Options

• Educated guessing
▪ Average interarrival time = 4.08 minutes
▪ Average service time = 3.46 minutes
▪ So (on average) parts are being processed faster than they 

arrive
– System has a chance of operating in a stable way in the long run, 

i.e., might not “explode”
– If all interarrivals and service times were exactly at their mean, there 

would never be a queue
– But the data clearly exhibit variability, so a queue could form

▪ If we’d had average interarrival < average service time, and 
this persisted, then queue would explode

▪ Truth — between these extremes
▪ Guessing has its limits …
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Analysis Options (cont’d.)

• Queueing theory
▪ Requires additional assumptions about the model
▪ Popular, simple model:  M/M/1 queue

– Interarrival times ~ exponential
– Service times ~ exponential, indep. of interarrivals
– Must have E(service) < E(interarrival)
– Steady-state (long-run, forever)
– Exact analytic results; e.g., average waiting time in queue is 

▪ Problems:  validity, estimating means, time frame
▪ Often useful as first-cut approximation
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Mechanistic Simulation

• Individual operations (arrivals, service times) will 
occur exactly as in reality

• Movements, changes occur at the right “time,” in 
the right order

• Different pieces interact
• Install “observers” to get output performance 

measures
• Concrete, “brute-force” analysis approach
• Nothing mysterious or subtle

▪ But a lot of details, bookkeeping
▪ Simulation software keeps track of things for you
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Pieces of a Simulation Model

• Entities
▪ “Players” that move around, change status, affect and are 

affected by other entities
▪ Dynamic objects — get created, move around, leave 

(maybe)
▪ Usually represent “real” things

– Our model:  entities are the parts
▪ Can have “fake” entities for modeling “tricks”

– Breakdown demon, break angel
Though Arena has built-in ways to model these examples directly

▪ Usually have multiple realizations floating around
▪ Can have different types of entities concurrently
▪ Usually, identifying the types of entities is the first thing to 

do in building a model
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Pieces of a Simulation Model (cont’d.)

• Attributes
▪ Characteristic of all entities:  describe, differentiate
▪ All entities have same attribute “slots” but different values 

for different entities, for example:
– Time of arrival
– Due date
– Priority
– Color

▪ Attribute value tied to a specific entity
▪ Like “local” (to entities) variables
▪ Some automatic in Arena, some you define
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Pieces of a Simulation Model (cont’d.)

• (Global) Variables
▪ Reflects a characteristic of the whole model, not of specific 

entities
▪ Used for many different kinds of things

– Travel time between all station pairs
– Number of parts in system
– Simulation clock (built-in Arena variable)

▪ Name, value of which there’s only one copy for the whole 
model

▪ Not tied to entities
▪ Entities can access, change variables
▪ Writing on the wall (rewriteable)
▪ Some built-in by Arena, you can define others
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Pieces of a Simulation Model (cont’d.)

• Resources
▪ What entities compete for

– People
– Equipment
– Space

▪ Entity seizes a resource, uses it, releases it
▪ Think of a resource being assigned to an entity, rather than 

an entity “belonging to” a resource
▪ “A” resource can have several units of capacity

– Seats at a table in a restaurant
– Identical ticketing agents at an airline counter

▪ Number of units of resource can be changed during the 
simulation
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Pieces of a Simulation Model (cont’d.)

• Queues
▪ Place for entities to wait when they can’t move on (maybe 

since the resource they want to seize is not available)
▪ Have names, often tied to a corresponding resource
▪ Can have a finite capacity to model limited space — have 

to model what to do if an entity shows up to a queue that’s 
already full

▪ Usually watch the length of a queue, waiting time in it 
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Pieces of a Simulation Model (cont’d.)

• Statistical accumulators
▪ Variables that “watch” what’s happening
▪ Depend on output performance measures desired
▪ “Passive” in model — don’t participate, just watch
▪ Many are automatic in Arena, but some you may have to 

set up and maintain during the simulation
▪ At end of simulation, used to compute final output 

performance measures
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Pieces of a Simulation Model (cont’d.)

• Statistical accumulators for the simple 
processing system
▪ Number of parts produced so far
▪ Total of the waiting times spent in queue so far
▪ No. of parts that have gone through the queue
▪ Max time in queue we’ve seen so far
▪ Total of times spent in system
▪ Max time in system we’ve seen so far
▪ Area so far under queue-length curve Q(t)
▪ Max of Q(t) so far
▪ Area so far under server-busy curve B(t)
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Simulation Dynamics:
The Event-Scheduling “World View”

• Identify characteristic events
• Decide on logic for each type of event to

▪ Effect state changes for each event type
▪ Observe statistics
▪ Update times of future events (maybe of this type, other 

types)
• Keep a simulation clock, future event calendar
• Jump from one event to the next, process, 

observe statistics, update event calendar
• Must specify an appropriate stopping rule
• Usually done with general-purpose programming 

language (C, FORTRAN, etc.)
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Events for the
Simple Processing System

• Arrival of a new part to the system
▪ Update time-persistent statistical accumulators (from last 

event to now)
– Area under Q(t)
– Max of Q(t)
– Area under B(t)

▪ “Mark” arriving part with current time (use later)
▪ If machine is idle:

– Start processing (schedule departure), Make machine busy, Tally 
waiting time in queue (0)

▪  Else (machine is busy):
– Put part at end of queue, increase queue-length variable

▪ Schedule the next arrival event
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Events for the
Simple Processing System (cont’d.)

• Departure (when a service is completed)
▪ Increment number-produced stat accumulator
▪ Compute & tally time in system (now - time of arrival)
▪ Update time-persistent statistics (as in arrival event)
▪ If queue is non-empty:

– Take first part out of queue, compute & tally its waiting time in 
queue, begin service (schedule departure event)

▪  Else (queue is empty):
– Make the machine idle (Note: there will be no departure event 

scheduled on the future events calendar, which is as desired)
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Events for the
Simple Processing System (cont’d.)

• The End
▪ Update time-persistent statistics (to end of the simulation)
▪ Compute final output performance measures using current 

(= final) values of statistical accumulators
• After each event, the event calendar’s top record 

is removed to see what time it is, what to do
• Also must initialize everything
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Some Additional Specifics for the
Simple Processing System

• Simulation clock variable (internal in Arena)
• Event calendar:  list of event records:

▪ [Entity No., Event Time, Event Type]
▪ Keep ranked in increasing order on Event Time
▪ Next event always in top record
▪ Initially, schedule first Arrival, The End (Dep.?)

• State variables: describe current status
▪ Server status B(t) = 1 for busy, 0 for idle
▪ Number of customers in queue Q(t)
▪ Times of arrival of each customer now in queue (a list of 

random length)
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Simulation by Hand

• Manually track state variables, statistical 
accumulators

• Use “given” interarrival, service times
• Keep track of event calendar
• “Lurch” clock from one event to the next
• Will omit times in system, “max” computations 

here (see text for complete details)
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System 
 

 

Clock 
 
19.39 

B(t) 
 
1 

Q(t) 
 
1 

Arrival times of 
custs. in queue 

(19.39) 

Event calendar 
[–, 20.00, End] 
[6, 23.05, Dep] 
[8, 34.91, Arr] 

Number of 
completed waiting 
times in queue 
6 
 

Total of 
waiting times in queue 
 
15.17 

Area under 
Q(t) 
 
15.17 

Area under 
B(t) 
 
17.73 

 
 
Q(t) graph 
 
 
 
 
B(t) graph 

 
 
 
 
 
 
 
 
 
 

Time (Minutes) 
Interarrival times 1.73, 1.35, 0.71, 0.62, 14.28, 0.70, 15.52, 3.15, 1.76, 1.00, ... 
Service times 2.90, 1.76, 3.39, 4.52, 4.46, 4.36, 2.07, 3.36, 2.37, 5.38, ... 

 
 

Simulation by Hand:
 t = 19.39, Arrival of Part 7
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Simulation by Hand:
 t = 20.00, The End
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System 
 

 

Clock 
 
20.00 

B(t) 
 
1 

Q(t) 
 
1 

Arrival times of 
custs. in queue 

(19.39) 

Event calendar 
[6, 23.05, Dep] 
[8, 34.91, Arr] 

Number of 
completed waiting 
times in queue 
6 
 

Total of 
waiting times in queue 
 
15.17 

Area under 
Q(t) 
 
15.78 

Area under 
B(t) 
 
18.34 

 
 
Q(t) graph 
 
 
 
 
B(t) graph 

 
 
 
 
 
 
 
 
 
 

Time (Minutes) 
Interarrival times 1.73, 1.35, 0.71, 0.62, 14.28, 0.70, 15.52, 3.15, 1.76, 1.00, ... 
Service times 2.90, 1.76, 3.39, 4.52, 4.46, 4.36, 2.07, 3.36, 2.37, 5.38, ... 
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Simulation by Hand:
Finishing Up

• Average waiting time in queue:

• Time-average number in queue:

• Utilization of drill press:

part per minutes 532
6
1715

queue in times of No.
queue in times of Total .. ==

part 790
20

7815
value clock Final

curve  under Area ..)( ==tQ

less)(dimension 920
20

3418
value clock Final

curve  under Area ..)( ==tB



Chapter 2 – Fundamental Simulation Concepts Slide 40 of 46Simulation with Arena, 3rd ed.

Complete Record of the Hand 
Simulation
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Event-Scheduling Logic via 
Programming

• Clearly well suited to standard programming 
language

• Often use “utility” libraries for:
▪ List processing
▪ Random-number generation
▪ Random-variate generation
▪ Statistics collection
▪ Event-list and clock management
▪ Summary and output

• Main program ties it together, executes events in 
order
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Simulation Dynamics:  The Process-
Interaction World View

• Identify characteristic entities in the system
• Multiple copies of entities co-exist, interact, 

compete
• “Code” is non-procedural
• Tell a “story” about what happens to a “typical” 

entity
• May have many types of entities, “fake” entities 

for things like machine breakdowns
• Usually requires special simulation software

▪ Underneath, still executed as event-scheduling
• The view normally taken by Arena

▪ Arena translates your model description into a program in 
the SIMAN simulation language for execution
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Randomness in Simulation

• The above was just one “replication” — a sample 
of size one (not worth much)

• Made a total of five replications:

• Confidence intervals for expected values:
▪ In general, 
▪ For expected total production, 

nstX n //, 211 −−
)/.)(.(. 56417762803 

042803 .. 

Note
substantial
variability
across
replications
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Comparing Alternatives

• Usually, simulation is used for more than just a 
single model “configuration”

• Often want to compare alternatives, select or 
search for the best (via some criterion)

• Simple processing system:  What would happen 
if the arrival rate were to double?
▪ Cut interarrival times in half
▪ Rerun the model for double-time arrivals
▪ Make five replications
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Results:  Original vs. Double-Time 
Arrivals

• Original – circles
• Double-time – triangles
• Replication 1 – filled in
• Replications 2-5 – hollow
• Note variability
• Danger of making 

decisions based on one 
(first) replication

• Hard to see if there are 
really differences

• Need:  Statistical analysis 
of simulation output data
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Overview of a Simulation Study

• Understand the system
• Be clear about the goals
• Formulate the model representation
• Translate into modeling software
• Verify “program”
• Validate model
• Design experiments
• Make runs
• Analyze, get insight, document results
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What We’ll Do ...

• Start Arena
• Load, explore, run an existing model

▪ Basically the same model as for the hand simulation in 
Chapter 2

▪ Browse dialogs and menus
▪ Run the model
▪ Look at results

• Construct the same model from scratch
• Tour menus, toolbars, drawing, printing
• Help system
• Options for running and control
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Behavior of Arena

• Arena is a true Windows application
▪ Appearance, operation, functions, are standard
▪ Interoperability with other software (MS Office, CAD)
▪ Interact, communicate with other software (Chapter 10)

• Assume you already know basics of Windows:
▪ Disks, files, folders, paths
▪ Mousing, keyboarding
▪ Resizing, moving, maximizing, minimizing windows
▪ Menu operations
▪ Ctrl, Alt, Shift keys
▪ Cut, copy, paste
▪ Filling out dialog fields
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Starting Up
• Installing Arena – Appendix E
• Locate icon or shortcut; double-click

▪ Or, Start > Programs > Rockwell Software > Arena 7.0 > 
Arena 7.01

▪ Licensed vs. Academic, Evaluation mode
• See File, View, Tools, Help menus

▪ Other menus present if a model file is open
• Toolbars with buttons

▪ Unless a model file is open, only New model file, Open 
model file, Template Attach/Detach, Context Help (click it, 
then click on buttons or menu items)

• Tooltips – roll over toolbar buttons for names
• Quitting Arena:  File > Exit or Alt+F4 or top right          

button
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Opening an Existing Model

• File > Open … or        button
▪ Navigate to desired disk/directory
▪ Click > Open or double-click Model 03-01.doe
▪ Book models: Rockwell Software\Arena 7.0\Book Examples
▪ More examples: Rockwell Software\Arena 7.0\Examples

• Model window (usually on right side of Arena 
window)
▪ Where model is built
▪ Resize, maximize, minimize, scroll/pan, zoom
▪ Can have multiple model windows open at once

• Cut, Copy, Paste within Arena, and between 
Arena and other applications (when sensible)

Why the .doe default 
extension to Arena model 
filenames?
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Flowchart and Spreadsheet Views

• Model window split into two views
▪ Flowchart view

– Graphics
– Process flowchart
– Animation, drawing
– Edit things by double-clicking on them, get into a dialog

▪ Spreadsheet view
– Displays model data directly
– Can edit, add, delete data in spreadsheet view
– Displays all similar kinds of modeling elements at once

▪ Many model parameters can be edited in either view
▪ Horizontal splitter bar to apportion the two views
▪ View > Split Screen (or push     ) to see both flowchart and 

spreadsheet views (otherwise, get just flowchart view)
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Project Bar

• Usually down the left edge of Arena window
• Hosts panels with modeling building blocks: 

modules
▪ Both flowchart and spreadsheet modules

• Displays one panel at a time
▪ Switch to different panels via horizontal buttons
▪ Panels for Basic Process, Reports (after running), Navigate 

(to different views within a model or to different hierarchical 
submodels), … others can be attached (Template Attach 
button      ) for different modeling levels, specialties

• Usually docked to left edge but can move, float
• Hide it via View > Project Bar or its own small
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Status Bar

• At very bottom of Arena window
• Displays various information sensitive to status

▪ Coordinates of cursor in “worldspace”
▪ Simulation clock value, replication number being executed, 

number of replications to be done, when simulation is 
running

• Hide by clearing (unchecking) View > Status Bar
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Moving Around, Up, Down
in Flowchart View of Model Window

• Underlying world space for model
▪ (x, y) coordinates, arbitrary units (thousands in each 

direction)

• Pan with scroll bars, arrow keys
• Zoom in (down):      or + key
• Zoom out (up):         or – key
• See all at min altitude:      or * key
• Named views

▪ Save a pan/zoom view for different parts of model
▪ Assign a Hot key (case-sensitive)
▪ Access via View > Named Views … or ? key

• Display grid (       ), snap to grid (       ) toggles

To navigate via 
keyboard, the model 
window must be 
active ... click in it.
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Modules

• Basic building blocks of a simulation model
• Two basic types:  flowchart and data
• Different types of modules for different actions, 

specifications
• “Blank” modules are on the Project Bar

▪ To add a flowchart module to your model, drag it from the 
Project Bar into the flowchart view of the model window

– Can have many instances of the same kind of flowchart module in 
your model

▪ To use a data module, select it (single-click) in the Project 
Bar and edit in the spreadsheet view of the model window

– Only one instance of each kind of data module in your model, but it 
can have many entries (rows) in the spreadsheet view

– Can edit via dialog – double-click on number in leftmost column
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Flowchart Modules

• Describe dynamic processes
▪ Nodes/places through which entities flow
▪ Typically connected to each other in some way

• Basic Process panel flowchart module types:
▪ Create, Dispose, Process, Decide, Batch, Separate, 

Assign, Record
• Other panels – many other kinds
• Shape like flowcharting (also use colors for hints)
• Two ways to edit

▪ Double-click to open up, then fill out dialogs
▪ Select (single-click) a module type in model or Project Bar, 

get all modules of that type in the spreadsheet view
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Data Modules
• Set values, conditions, etc. for whole model

▪ No entity flow, no connections
• Basic Process panel data module types:

▪ Entity, Queue, Resource, Variable, Schedule, Set
• Other panels – many other kinds
• Icons in Project Bar look like little spreadsheets
• To use a data module, select it (single-click) in the 

Project Bar, edit in spreadsheet view
▪ Can edit via dialog – double-click in leftmost column
▪ Double-click where indicated to add new row
▪ Right-click on row, column to do different things

• Only one instance of each kind of data module in 
a model
▪ But each one can have many entries (rows)
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Relations Among Modules

• Flowchart and data modules are related via 
names for objects
▪ Queues, Resources, Entity types, Variables … others

• Arena keeps internal lists of different kinds of 
names
▪ Presents existing lists to you where appropriate
▪ Helps you remember names, protects you from typos

• All names you make up in a model must be 
unique across the model, even across different 
types of modules
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Internal Model Documentation

• Data Tips on modules, graphics – hover mouse 
over object to see
▪ Default part – generic info on object (name, type)
▪ User-defined part – right-click on object, select Properties, 

enter text under Property Description
▪ Toggle display of Data tips via View > Data Tips

• Project Description – Run > Setup > Project 
Parameters, enter text under Project Description

• Model Documentation Report – Tools > Model 
Documentation Report
▪ Generates HTML file with model details (can choose which 

kinds of details to include)
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Browsing Through Model 3-1

• Open Model 03-01.mod (in Book Examples 
folder)

• Three flowchart modules (Create, Process, 
Dispose)

• Entries in three data modules (Entity, Queue, 
Resource)

• Animation objects
▪ Resource animation
▪ Two plots
▪ Some (passive) labels, artwork
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The Create Flowchart Module

• “Birth” node for entities
• Gave this instance of the Create-type module the 

Name Part Arrives to System
▪ If we had other Create modules (we don’t) they’d all have 

different Names
• Double-click on module to open property dialog:
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The Create Flowchart Module (cont’d.)

• Name – for module (type it in, overriding default)
• Entity Type – enter a descriptive name

▪ Can have multiple Entity Types with distinct names
• Time Between Arrivals area

▪ Specify nature of the time separating consecutive arrivals
▪ Type – pull-down list with several options
▪ Value – depends on Type … for Random (Expo) is mean
▪ Units – time units for Value

• Entities per Arrival – constant, random variable, 
very general “Expression” (more later …)

• Max Arrivals – choke off arrivals (from this 
source) after this many entities

• First Creation – time of first arrival (need not be 0)
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Editing Flowchart Modules in the 
Spreadsheet View

• Alternative to dialog for each instance of a 
module type

• See all instances of a module type at once
▪ Convenient for seeing, editing lots of things at once

• Selecting a module in either flowchart or 
spreadsheet view also selects it in the other view

• Click, double-click fields to view, edit
• Right-click in row to Edit via Dialog, define a user 

Data Tip (via Properties)
• Right-click in expression fields to get Expression 

Builder for help in constructing complex 
expressions with Arena variables (more later …)
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The Entity Data Module

• A data module, so edit in spreadsheet view only
• View, edit aspects of different Types of entities in 

your model (we have just one Type, Part)
• Pull-down lists activated as you select fields
• Our only edit – Initial Picture for animation

▪ We picked Picture.Blue Ball from the default list
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The Process Flowchart Module

• Represents the machine, including the resource, 
queue, and entity delay time (processing)

• Enter Name – Drilling Center
• Type – picked Standard to define logic here 

rather than in a submodel (more later …)
• Report Statistics check box at bottom

▪ To get utilizations, queue lengths, queue waiting times, etc.
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The Process Flowchart Module (cont’d.)

• Logic area – what happens to entities here
▪ Action

– Seize Delay Release – entity Seizes some number of units of a Resource 
(maybe after a wait in queue), Delay itself there for the processing time, 
then Release the units of the Resource it had Seized – we chose this option

– Could just Delay entity (red traffic light) – no Resources or queueing
– Could also Seize Delay (no Release … Release downstream)
– Could also Delay Release (if Resource had been Seized upstream)
– Priority for seizing – lower numbers mean higher priority
– Different Action choices could allow stringing together several Process 

modules for modeling flexibility

▪ Resources – define Resource(s) to be seized, released
– Double-click on row to open subdialog
– Define Resource Name, Quantity of units to be Seized/Released here
– Several Resources present (Add) – entities must first Seize all
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The Process Flowchart Module (cont’d.)

• Delay Type – choice of probability distributions, 
constant or general Expression (more later …)

• Units – time units for the delay (don’t ignore)
• Allocation – how to “charge” delay in costing 

(more later …)
• Prompts on next line – change depending on 

choice of Delay Type – specify numerical 
parameters involved

• Can also edit in spreadsheet view
▪ Subdialogs (e.g., Resource here) become secondary 

spreadsheets that pop up, must be closed
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The Resource Data Module

• Defining the Drilling Center Resource in the 
Process module automatically creates an entry 
(row) for it in the Resource data module

• Can edit it here for more options
▪ Type – could vary capacity via a Schedule instead of 

having a fixed Capacity
– Would define the Schedule via Schedule data module … more later

▪ Failures – could cause resource to fail according to some 
pattern

– Define this pattern via Failure data module (Advanced Process 
panel) … more later



Simulation with Arena, 3rd ed. Chapter 3 – A Guided Tour Through Arena Slide 24 of 61

The Queue Data Module

• Specify aspects of the queues in the model
▪ We only have one, named Drilling Center.Queue 

(the default name given the Process name)
• Type – specifies queue discipline or ranking rule

▪ If Lowest or Highest Attribute Value, then another field 
appears where you specify which attribute

• Shared – it this queue will be shared among 
several resources (more later …)

• Report Statistics – check to get automatic 
collection and reporting of queue length, time in 
queue
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Animating Resources and Queues

• Got queue animation                    automatically by 
specifying a Seize in the Process module
▪ Entity pictures (blue balls) will line up here in animation

• Don’t get Resource animation automatically
▪ To add it, use Resource button     in Animate toolbar … get 

Resource Picture Placement dialog
– Identifier – link to Resource name in pull-down list
– Specify different pictures for Idle, Busy state

For pre-defined artwork, Open a picture library (.plb filename extension)
Scroll up/down on right, select (single-click) a picture on right, select Idle or Busy 

state on left, then        to copy the picture

▪ To edit later, double-click on picture in flowchart view
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The Dispose Flowchart Module

• Represents entities leaving model boundaries
• Name the module
• Decide on Record Entity Statistics (average and 

maximum time in system of entities exiting here, 
costing information)

Check boxes for statistics collection and reporting:
▪ Most are checked (turned on) by default
▪ Little or no modeling effort to say yes to these
▪ However, in some models this can slow execution markedly
▪ Moral – if you have speed problems, clear these if you don’t care about them
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Connecting Flowchart Modules
• Establishes the (fixed) sequence of flowchart 

modules through which entities will flow
• To make a connection

▪ Click Connect button       (or Object > Connect)
▪ Cursor changes to cross hairs
▪ Click on exit point      from source module, then entry point    

on destination module
▪ Make intermediate clicks for non-straight line in segments

• Object menu toggles
▪ Auto-Connect – automatically connect entry point of newly 

placed module from exit point of selected module
▪ Smart Connect – force segments to horizontal/vertical
▪ Animate Connectors – show entities moving along 

connectors (zero time for statistics collection)
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Dynamic Plots
• Trace variables, queues as simulation runs – a 

kind of “data animation”
• Disappear after run is ended (to keep, must save 

data, postprocess via Output Analyzer — later)
• Plot button      from Animate toolbar… “Add” for

▪ Expression to plot (help via Expression Builder … later)
▪ Min/Max y-axis values (initially guesses, maybe revise)

– Arena can do this automatically and dynamically in Plot dialog
▪ Number of “corners” to show (# History Points) at a time
▪ Stepped option (for piecewise-constant curves)
▪ Colors

• In Plot dialog – Time Range (x axis), cosmetics, 
automatic scaling options

• Drop plot in via crosshairs (resize, move later)
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Dressing Things Up

• Add drawing objects from Draw toolbar
▪ Similar to other drawing, CAD packages
▪ Object-oriented drawing tools (layers, etc.), not just a 

painting tool
• Add Text to annotate things

▪ Control font, size, color, orientation
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Setting the Run Conditions

• Run > Setup menu dialog – five tabs
▪ Project Parameters – Title, your name, output statistics, 

Project Description
▪ Replication Parameters

– Number of Replications
– Initialization options Between Replications
– Start Date/Time to associate with start of simulation
– Warm-up Period (when statistics are cleared)
– Length of Replication (and Time Units)
– Base Time Units (output measures, internal computations)
– Hours per “Day” (convenience for 16-hour days, etc.)
– Terminating Condition (complex stopping rules)

▪ Other tabs for animation speed, run conditions, reporting
Terminating your simulation:
▪ You must specify – part of modeling
▪ Arena has no default termination
▪ If you don’t specify termination, Arena will usually keep running forever
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Running It

• Plain-vanilla run:  Click      from Standard toolbar 
(like audio/video players)
▪ First time or after changes:  Check
▪ Enters run mode — can move around but not edit
▪ Speed up (> on keyboard) or slow down (<) animation 

display
▪ When done, asked if you want to see summary reports
▪ Click      to get out of run mode (can’t edit until you do)
▪ Can pause run with     or Esc key

• Other run control, viewing, checking options
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Viewing the Reports

• Click Yes in the Arena box at the end of the run
▪ Opens up a new reports window (separate from model 

window) inside the Arena window
▪ Project Bar shows Reports panel, with different reports 

(each one would be a new window)
▪ Remember to close all reports windows before future runs

• Default installation shows Category Overview 
report – summarizes many things about the run
▪ Reports have “page” to browse (       and       )
▪ Also, “table contents” tree at left for quick jumps via     ,

• Times are in Base Time Units for the model
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Viewing the Reports – Examples
• Entity → Time → Total Time → Part:

▪ Avg. time in system was 6.4397 min., max was 12.6185
• Resource → Usage → Instantaneous Utilization → 

Drill Press:
▪ Utilization was 0.9171 (busy 91.71% of the time)

• Process → Other → Number In → Drilling Center:
▪ During the run, 7 parts entered the Drilling Center

• Process → Other → Number Out → Drilling Center:
▪ 5 entities left the Drilling Center (so were produced)

• Entity → Time → Wait Time → Part:
▪ Avg. wait time in all queues was 3.0340 min. (counts only 

entities that left the system, but Queue → Time → Waiting 
Time → Drilling Center.Queue counts all entities that left 
this queue, so can differ)

• Entity → Other → Wip → Part:
▪ Average Work in Process was 1.7060, max WIP was 4
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Types of Statistics Reported

• Many output statistics are one of three types:
▪ Tally – avg., max, min of a discrete list of numbers

– Used for discrete-time output processes like waiting times in queue, 
total times in system

▪ Time-persistent – time-average, max, min of a plot of 
something where the x-axis is continuous time

– Used for continuous-time output processes like queue lengths, WIP, 
server-busy functions (for utilizations)

▪ Counter – accumulated sums of something, usually just 
nose counts of how many times something happened

– Often used to count entities passing through a point in the model
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More on Reports and their Files

• Reports we just saw – based on a MS Access 
database that Arena writes as it runs
▪ Can be saved and viewed later
▪ Viewing within Arena done via Crystal Reports to query the 

Access database
• Arena also produces a plain-text summary report 

(.out filename extension)
▪ Was in previous versions of Arena, underlying SIMAN 

simulation language
▪ Fairly cryptic, but gives quick view of lots of output data

• Get multiple reports for multiple replications
• “Half Width” columns – for confidence intervals 

on outputs in long-run simulations … more later
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Build It Yourself

• Build the same model from scratch – see book for 
more detail

• Handy user-interface tricks:
▪ Right-click in an empty spot in flowchart view – small box of 

options, including Repeat Last Action … useful in repetitive 
editing like placing lots of the same module type

▪ Ctrl+D or Ins key – duplicates whatever’s selected in 
flowchart view, offsetting it a bit … usually drag elsewhere 
and edit

• Open a new (blank) model window – name it, save 
it, maybe maximize it

• Attach modeling panels you’ll need to Project Bar 
if they’re not there



Simulation with Arena, 3rd ed. Chapter 3 – A Guided Tour Through Arena Slide 37 of 61

Build It Yourself (cont’d.)

• Place and connect flowchart modules
• Edit flowchart and data modules as needed

▪ Experiment with Expression Builder – right-click in 
expression field

• Add plots, animation, artwork
• Add named views (? key or View > Named Views)

▪ Name, hot key (case-sensitive) – useful in big models
• Edit Run > Setup dialog
• “Displays” in text

▪ Compact way of saying what needs to be done in a dialog
▪ Omits Arena defaults
▪ Shows completed dialogs
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Display for the Create Module
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Display for the Process Module
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Display for the Dispose Module
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Display for the Queue-Length Plot
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Expression Builder for Queue-Length-
Plot Expression
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More on Menus – File Menu

• Model-file management
• Template attach/detach
• DXF import (from CAD packages), Visio import
• Color palettes
• Printing
• E-mail open model file
• Recent models
• Exit from Arena
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Edit Menu

• Undo/Redo
• Cut/Copy/Paste
• Paste Link (create OLE link)
• Duplicate, Delete selection
• Select/Deselect All
• Entity Pictures – change content, definition of 

pictures presented in Entity data module
• Calendar Schedules – specify complex time 

patterns in hierarchies (weeks are made of days, 
which are made of shifts, etc.), exceptions 
(holidays), view composite net effect
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Edit Menu (cont’d.)

• Find – searches all modules and animation 
objects for a text string … useful for finding 
wrong names, typos after an error message from 
Arena

• Properties – display internal Arena object 
properties

• Links – to link to other files (spreadsheets, 
sounds, etc.)

• Insert New Object – from other applications (e.g., 
graphics)

• Object – edit object imported from another 
application
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View Menu

• Zooming – discussed before
• Zoom Factor – step size when zooming
• Views – canned Arena views of flowchart view
• Named Views – define, change, use views
• Grid/Snap/Grid Settings – control grid, snapping
• Page breaks – shows page breaks if printed
• Data Tips – toggles display of Data Tips
• Layers – which objects show up in which mode
• Split Screen – toggle for viewing both flowchart 

and spreadsheet views, or just one of them
• Toolbars – decide which toolbars show up
• Project/Status Bar – toggle to show up or not
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Tools Menu

• Separate applications for modeling, analysis
▪ Arena Symbol Factory – large collection of graphics in 

categories, use to create graphical symbols for animation
▪ Input Analyzer – fit probability distributions for input, using 

field-collected data
▪ Process Analyzer – run, compare many “scenarios” at once

– Also Output Analyzer … not on menus ... start from Start menu
• Special “editions” of Arena (FactoryAnalyzer, 

Contact Center) – depends on licensing
• Model Documentation Report – generate HTML 

file with many details of this model
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Tools Menu (cont’d.)

• Import/Export model to/from Database – bring in, 
save model details to Excel or Access

• OptQuest for Arena – separate application that 
“takes over” running of the model to search for 
an optimal scenario

• Macro – create Visual Basic macros (mini 
programs), VB editor ... more in Chapter 10

• Options – control many aspects of how Arena 
works, looks
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Arrange Menu
• For modeling, graphics objects – first select 

object(s)
• Bring object to Front, Send it to Back — for 

“stacking” effects
• Group, Ungroup
• Flip around Vertical, Horizontal line
• Rotate object (90° clockwise)
• Align objects on top, bottom, left, or right edges
• Distribute objects evenly (horizontally, vertically)
• Flowchart Alignment – arrange flowchart modules 

(horizontally, vertically)
• Snap to Grid the selected object(s)
• Change Snap Point on object that gets snapped
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Object Menu

• Connect tool – changes cursor to cross hairs
• Auto-Connect newly placed module to selected 

module – toggle on/off
• Smart Connect – new connections in 

horizontal/vertical segments rather than one 
diagonal segment – toggle on/off

• Animate Connectors – to show entities moving 
(at infinite speed for statistics collection)

• Submodel – define and manage hierarchical 
submodels (see Chapter 5)
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Run Menu

• Setup – control model run conditions
• Entries to run, check, pause, step through
• Alternatives to watch execution, view results (or 

errors)
• Control how run goes and is displayed
• Most capabilities on Run or Run Interaction 

Toolbar, and will be described a bit later in detail
• Access the “code” in the underlying SIMAN 

simulation language
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Window Menu

• Cascade, Tile multiple open model windows
• Arrange Icons for any minimized model windows
• Use system Background Color — use Windows 

colors rather than Arena settings
• List of open model windows
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Help Menu

• One of several ways to get into Help system
• Arena Help Topics – TOC, Index, Search
• What’s This? – adds ? to cursor, then click on 

things for brief description
• Release notes – recent changes, requirements
• Arena SMART Files – subject-based index to 

many small (but complete) models that illustrate 
specific modeling techniques
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Help Menu (cont’d.)

• List of attached modeling panels – select to get 
Help on that one

• Product Manuals – detailed documents on Arena 
components

• Web links to product support (must be online ...)
• Product support/training
• Copy protection information for commercial, 

research, and lab versions
• About Arena... – version number, etc.
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More on Toolbars
• Collections of buttons for “frequent” operations

▪ Most are duplication of menu entries
▪ Standard, Draw, Animate, Integration, View, Arrange, Run 

Interaction, Record Macro, Animate Transfer, Professional
• View > Toolbars (or right-click in a toolbar area) 

to decide which ones show up, which to hide
• Toolbars can be torn off (“floating” palettes), or 

“docked” to an edge of screen
• Arena remembers your Toolbar configuration for 

next time
• View > Toolbars > Customize to alter how 

toolbars and buttons are displayed
• See text for run-through description of toolbars 

and buttons



Simulation with Arena, 3rd ed. Chapter 3 – A Guided Tour Through Arena Slide 56 of 61

More on Drawing

• Draw via toolbar buttons only (no menus):

• Line, Polyline (hold Shift key for 450), Arc, Bézier 
Curve

• Box, Polygon, Ellipse (fill, line, shade)
• Text (font, size, style)
• Colors for Lines, Fill, Text, Window Background
• Line Style, Fill Pattern
• By far best way to learn:  just play around
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Printing

• Print all or parts of flowchart view of active model 
window – supports color

• Usual Print, Print Preview, Print Setup (File menu)
• Could consume many pages … also prints named 

views separately
▪ Print Preview, select only what you want for printing

• View > Page Breaks to show how pages will break
• Alternative to printing directly from Arena: 

PrintScreen key — sends screen to clipboard, 
paste into another application
▪ Alt+PrintScreen — sends only active window to clipboard
▪ Could first pass through a paint application to crop, etc.
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Help!
• Extensive, comprehensive online system –  

including complete (electronic) manuals
• Interlinked via hypertext for cross referencing
• Multiple entry points, including Help menu 

(described above), links to websites
•       button for context-sensitive help
•              button in most dialogs
•      button (What’s This?) for info on items
• Tooltips – roll over things, get little sticky note
• Examples folder inside Arena 7.0 folder
• SMARTs library – small models illustrating points 

– subject index via Help > Arena Smart Files
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More on Running Models
• Run Menu; Standard & Run Interaction toolbars
• Run > Setup – many options to control the run

▪ These are attached to the model, and are not global
• Run > Go      – run simulation “normally” 

(depends on selections from Run > Run Control 
and Tools > Options > Run Control)

• Run > Step       – one “step” at a time (verify, 
debug)

• Run > Fast-Forward       – disable animation 
(faster)

• Run > Pause      (or Esc key) – freeze run, resume 
with Go

• Run > Start Over      – go back to beginning of 
simulation
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More on Running Models (cont’d.)

• Run > End      – get out of run mode
• Run > Check Model      – like compiling
• Run > Review Errors – for most recent Check
• Run > Run Control > Command      – bring up 

interactive command-line window to control run
• Run > Run Control > Break      – set times, 

conditions to interrupt for checks, illustration
• Run > Run Control > Watch      – bring up a 

window to watch a variable or expression during 
run
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More on Running Models (cont’d.)

• Run > Run Control > Break on Module      – 
set/clear break when an entity enters or resumes 
activity on a module

• Run > Run Control > Highlight Active Module – 
highlight the flowchart module being executed

• Run > Run Control > Batch Run (No Animation) – 
run model with no animation … this is even faster 
than Fast-Forward … usually used for 
“production runs” for statistical analysis

• Run > SIMAN – view or write the model (.mod) 
and experiment (.exp) files for the underlying 
SIMAN model
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What We’ll Do ...

• Model 4-1:  Electronic assembly/test system
 Modeling approaches
 New Arena modules (Decide, Record)

• Model 4-2:  Enhanced electronic assembly/test
 Resource Schedules, States, and Failures
 Frequency outputs
 More on utilizations

• Model 4-3:  Enhancing the animation
 Queues, Entity Pictures, Resource Pictures
 Adding Plots and Variables
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What We’ll Do ... (cont’d.)

• Model 4-4:  Adding entity travel times
 Modify with Stations, Transfers, Routes, animation of entity 

movement
• Input analysis

 Specifying input distributions, parameters
 Deterministic vs. random input
 Collecting and using data
 Fitting input distributions via the Input Analyzer
 No data?
 Nonstationary arrival processes
 Multivariate and correlated input data
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Electronic Assembly/Test System
(Model 4-1)

• Produce two different sealed elect. units (A, B)
• Arriving parts:  cast metal cases machined to 

accept the electronic parts
• Part A, Part B – separate prep areas
• Both go to Sealer for assembly, testing – then to 

Shipping (out) if OK, or else to Rework
• Rework – Salvaged (and Shipped), or Scrapped
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Part A

• Interarrivals:  expo (5) minutes
• From arrival point, proceed immediately to Part A 

Prep area
 Process = (machine + deburr + clean) ~ tria (1,4,8) minutes

• Go immediately to Sealer
 Process = (assemble + test) ~ tria (1,3,4) min.
 91% pass, go to Shipped; Else go to Rework

• Rework: (re-process + testing) ~ expo (45)
 80% pass, go to Salvaged; Else go to Scrapped
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Part B

• Interarrivals:  batches of 4, expo (30) min.
• Upon arrival, batch separates into 4 individual 

parts
• From arrival point, proceed immediately to Part B 

Prep area
 Process = (machine + deburr +clean) ~ tria (3,5,10)

• Go to Sealer
 Process = (assemble + test) ~ weib (2.5, 5.3) min. , 

different from Part A, though at same station
 91% pass, go to Shipped; Else go to Rework

• Rework: (re-process + test) = expo (45) min.
 80% pass, go to Salvaged; Else go to Scrapped
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Run Conditions, Output

• Start empty & idle, run for four 8-hour shifts 
(1,920 minutes)

• Collect statistics for each work area on
 Resource utilization
 Number in queue
 Time in queue

• For each exit point (Shipped, Salvaged, 
Scrapped), collect total time in system (a.k.a. 
cycle time)
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Developing a Modeling Approach
• Define pieces of model, modules, data structures, 

control logic
• Appropriate level of detail – judgment call
• Often multiple ways to model, represent logic
• This model:

 Entities are the individual parts (two types)
 Separate Create modules for two part types
 Separate Process modules for each Prep area
 Process modules for Sealer and Rework, each followed by 

a Decide module (2-way by Chance)
 Depart modules for Shipped, Salvaged, Scrapped
 Attribute Sealer Time assigned after Creates in Assign 

modules (parts have different times at the Sealer)
 Record modules just before Departs for time in system

هذاقنإ مت هؤاغلإ مت
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Building the Model

• New model window
• Attach Basic Process panel (if needed)
• Place modules

 Create (x 2)
 Assign (x 2)
 Process (x 4)
 Decide (x 2)
 Record (x 3)
 Dispose (x 3)

• Right click — repeat last action (place module)
• Auto-Connect, or manually connect via 

Alternate strategy – 
place one module 
at a time, fill it out 
completely
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Part A Create Module

• Name: Part A Arrive
• Entity Type: Part A
• Time Between Arrivals

 Type: Random (Expo)
– Pull-down list with options

 Value: 5
 Units: Minutes

– Pull-down list with options

• Default what’s not mentioned above

Once these entries are 
made, they are placed on 
the list for names of that 
type (Module Name, 
Entity Type, etc.) and will 
appear on future pull-
down lists for that type of 
name.
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Part B Create Module

• Name: Part B Arrive
• Entity Type: Part B
• Time Between Arrivals

 Type: Random (Expo)
– Pull-down list with options

 Value: 30
 Units: Minutes

– Pull-down list with options

• Entities per Arrival: 4
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Part A Attributes Assign Module

• Name: Assign Part A Sealer and Arrive Time
• Add button:

 Type: Attribute
 Attribute Name: Sealer Time
 New Value: TRIA(1, 3, 4)

• Add button:
 Type: Attribute
 Attribute Name: Arrive Time
 New Value: TNOW (to compute time in system on exit)

TNOW is the internal Arena variable name for the simulation clock; see
Help > Arena Help > Contents >
      Variables, Functions, and Distributions > Date and Time Variables
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Part B Attributes Assign Module

• Name: Assign Part B Sealer and Arrive Time
• Add button:

 Type: Attribute
 Attribute Name: Sealer Time
 New Value: WEIB(2.5, 5.3)

• Add button:
 Type: Attribute
 Attribute Name: Arrive Time
 New Value: TNOW

Names for things in Arena
– Default names usually suggested
– Names placed on appropriate pull-down lists for future reference
– All names in a model must be unique (even across different kinds of objects)
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Process Module Actions
• Delay

Entity just sits here for the specified time; no Resource 
involved, so multiple entities could be undergoing this Delay 
simultaneously

• Seize Delay
Entity must first Seize the specified number of units of a 
Resource (possibility for Queueing if they’re not available), 
then undergoes the Delay … assume that the entity will 
Release the Resource units at another downstream module

• Seize Delay Release
Like Seize Delay, but entity releases Resource units after 
Delay (what we want in this model)

• Delay Release
Assumes entity had already Seized Resource units at another 
upstream module, now Delays and Releases Resource units
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Prep A Process Module

• Name: Prep A Process
• Action: Seize Delay Release
• Resources subdialog (Add button):

 Type: Resource (a pull-down option)
 Resource Name: Prep A
 Quantity: 1 (default)

• Delay Type: Triangular
• Units: Minutes
• Minimum: 1
• Value (Most Likely): 4
• Maximum: 8

If several Resources 
were named (Add 
button), entity would have 
to Seize them all before 
the Delay could start.
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Prep B Process Module

• Name: Prep B Process
• Action: Seize Delay Release
• Resources subdialog (Add button):

 Type: Resource (a pull-down option)
 Resource Name: Prep B
 Quantity: 1 (default)

• Delay Type: Triangular
• Units: Minutes
• Minimum: 3
• Value (Most Likely): 5
• Maximum: 10
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Sealer Process Module

• Name: Sealer Process
• Action: Seize Delay Release
• Resources subdialog (Add button):

 Type: Resource (a pull-down option)
 Resource Name: Sealer
 Quantity: 1 (default)

• Delay Type: Expression
• Units: Minutes
• Expression: Sealer Time Recall – Sealer Time attribute 

was defined upstream for both 
Parts A and B … now its value is 
being used … allows for different 
distributions for A and B.
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Sealer Inspection-Result Decide Module

• Decide module provides branch points
 By Condition (entity Attributes, global Variables)
 By Chance (multi-sided, possibly-biased hypercoin flip)

• Name: Failed Sealer Inspection
• Type: 2-way by Chance (default)
• Percent True: 9
• Different exit points for True, False results – 

connect appropriately downstream
− Note it’s percent true, not probability of true … so “9” means probability of 0.09
− We arbitrarily decided “true” meant part failed inspection … could have reversed 

(but would change numerical results ... why? ... does this upset you? ... why?)
− This is a rich, deep, versatile module … explore its Help button
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Rework Process Module

• Name: Rework Process
• Action: Seize Delay Release
• Resources subdialog (Add button):

 Type: Resource (a pull-down option)
 Resource Name: Rework
 Quantity: 1 (default)

• Delay Type: Expression
• Units: Minutes
• Expression: EXPO(45) Had to use the general Expression 

choice for Delay Type since what we 
want (EXPO) is not directly on the 
Delay Type pull-down list.
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Rework Inspection-Result Decide 
Module

• Name: Failed Rework Inspection
• Type: 2-way by Chance (default)
• Percent True: 20

We arbitrarily decided “true” 
meant part failed inspection
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Record Modules

• Arena collects and reports many output statistics 
by default, but sometimes not all you want

• We want time in system (average, max) of parts 
sorted out by their exit point (Shipped, Salvaged, 
Scrapped)
 It’s this sorting that Arena doesn’t do by default ... it would 

automatically sort by Entity Type if we had Entities checked 
in Run > Setup > Project Parameters (which we don’t)

• Record module can be placed in the flowchart to 
collect and report various kinds of statistics from 
within the model run as entities pass through it

• For Tally-type output performance measures (see 
Chapter 3)
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Shipped Parts Record Module

• Name: Record Shipped Parts
• Type: Time Interval

 This option records the length of time that elapsed up to 
now (TNOW) from when an entity attribute was marked with 
a time “stamp” upstream ... Attribute Name is below ...

 There are several other options for Type … explore via 
Record module’s Help button!

• Attribute Name: Arrive Time
 Was defined upstream as the clock value in the Assign 

modules instantly after each entity was Created
• Tally Name: Record Shipped Parts

 Determines the label in the reports Other two Record modules –
just like this except for Name 
and Tally Name.
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Dispose Modules

• Three separate exit points for three separate part 
disposition (Shipped, Salvaged, Scrapped)

• Could have directed all three exit types to a 
single Dispose module
 But having separate ones produces animation counts of the 

three dispositions
• Also, having separate Dispose modules allows 

for differentially checking the boxes to Record 
Entity Statistics
 Produces flow statistics separated by entity type (if Entities 

Statistics Collection is checked in Run > Setup > Project 
Parameters), not by final disposition of part … so we did 
need our Record modules and Arrive Time attribute
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Run > Setup for Run Control

• Without this, model would run forever – no 
defaults for termination rule
 That’s part of modeling, and generally affects results!

• Project Parameters tab:
 Fill in Project Title, Analyst Name
 Defaults for Statistics Collection, but we cleared the check 

box for Entities – not needed for what we want (we installed 
our own Record modules), and would slow execution

• Replication Parameters tab:
 Replication length: 32, accept Hours default for Time Units
 Base Time Units: Minutes for inputs without Time Units 

option, internal arithmetic, and units on output reports
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Different Part A, B Entity Pictures

• Entity data module (just single-click on it in 
Project Bar, edit via spreadsheet only)

• Row for each Entity Type (Part A, Part B)
• Pull down Initial Picture pull-down menu, select 

different pictures for each Entity Type
 Edit > Entity Pictures to see, change the list of pictures 

that’s presented here … more later







Simulation with Arena, 3rd ed. Chapter 4 – Modeling Basic Operations and Inputs Slide 26 of 66

Running the Model

• Check       (if desired)
 Find button to help find errors

• Go       (will automatically pre-Check if needed)
 Some graphics don’t show during run … will return when 

you End your run … control via View > Layers
 Status Bar shows run progress – replication number, 

simulation time, simulation status
• Animation speed – increase (>), decrease (<)
• Pause (    ) or Esc key;      to resume
• Run > Step (     ) to debug
• Run > Fast-Forward (     ) to turn off animation

 Run > Run Control > Batch Run (No Animation) is fastest
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Viewing the Results

• Counters during animation for modules
 Create, Dispose, Decide – incremented when entity leaves
 Process – number of entities currently in the module

• Asked at end if you want to see reports
 What you get depends on Run > Setup > Project Parameters

– Looks like the Rework area is a bottleneck ... more later
 Navigate through report with browsing arrows, tree at left
 Tally, Time-Persistent, and Counter statistics
 Avg, Min, Max, and 95% Confidence Interval half-widths

– Confidence intervals are for steady-state expectations … more later
– May not be produced if run is not long enough for reliable stats

• Generally difficult/unreliable to draw conclusions 
from just one run … more later
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Model 4-2: The Enhanced Electronic 
Assembly and Test System

• A Story
 Original model shown to production manager
 Pointed out that this is only the first shift of a two-shift day 

— on second shift there are two operators at Rework (the 
bottleneck station) … 16-hour days

 Pointed out that the Sealer fails sometimes
– Uptimes ~ exponential, mean 2 hours
– Repair times ~ exponential, mean 4 minutes

 Wants to buy racks to hold rework queue
– A rack holds 10 parts
– How many racks should be bought?

 Run for 10 days
• Need:  Resource Schedules, Resource States, 

Resource Failures
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Change Run Conditions

• Redefine a “day” to be 16 hours – Run > Setup > 
Replication Parameters

• Change Replication Length to 10 (of these) days

Run for 10 days
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Schedules

• Vary Capacity (number of units) of a resource 
over time

• In Resource Data module (spreadsheet view)
 For Rework Resource, change Type from Fixed 
Capacity to Based on Schedule

 Two new columns – Schedule Name and Schedule Rule
 Type in a schedule name (Rework Schedule)
 Select a Schedule Rule – details of capacity decrease if the 

Resource is allocated to an entity
– Ignore – Capacity goes down immediately for stat collection, but 

work goes on until finished … “break” could be shorter or gone
– Wait – Capacity decrease waits until entity releases Resource, and 

“break” will be full but maybe start/end late
– Preempt – Processing is interrupted, resumed at end of “break”
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Schedules (cont’d.)

• Define the actual Schedule the Resource will 
follow – Schedule data module (spreadsheet)
 Row already there since we defined Rework Schedule
 Format Type is Duration for entries based on time past 

simulation beginning
 Type is Capacity, for Resource schedule (more later on 

Arrival Type)
 Click in Durations column, get Graphical Schedule Editor 

– X-axis is time, Y-axis is Resource Capacity
– Click and drag to define the graph
– Options button to control axis scaling, time slots in editor, whether 

schedule loops or stays at a final level forever
– Can use Graphical Schedule Editor only if time durations are 

integers, and there are no Variables or Expressions involved
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Schedules (cont’d.)

 Alternatively, right-click in the row, select Edit via Dialog
– Enter schedule Name
– Enter pairs for Capacity, Duration … as many pairs as needed

If all durations are specified, schedule repeats forever
If any duration is empty, it defaults to infinity

– Can involve Variables, Expressions

 Another alternative – right-click in the row, select Edit via 
Spreadsheet

– Enter capacity Value, Duration pairs
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Resource Failures

• Usually used to model unplanned, random 
downtimes

• Can start definition in Resource or Failure module 
(Advanced Process panel) … we’ll start in Failure

• Attach Advanced Process panel if needed, single-
click on Failure, get spreadsheet view

• To create new Failure, double-click – add new row
• Name the Failure
• Type – Time-based, Count-based (we’ll do Time)
• Specify Up, Down Time, with Units
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Resource Failures (cont’d.)

• Attach this Failure to the correct Resource
 Resource module, Failures column, Sealer row – click
 Get pop-up Failures window, pick Failure Name Sealer 
Failure from pull-down list

 Choose Failure Rule from Wait, Ignore, Preempt (as in 
Schedules)

• Can have multiple Failures (separate names)
• Can re-use defined Failures for multiple 

Resources (operate independently)
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Frequencies

• Record time-persistent occurrence frequency of 
variable, expression, or resource state
 Use here to record % of time rework queue is of length 0, 

(0, 10], (10, 20], … to give info on number of racks needed
• Statistic data module (Advanced Process panel)

 Five Types of statistics, of which Frequencies is one
 Specify Name (Rework Queue Stats), Frequency Type 

(Value)
 Specify Expression to track and categorize

– Right-click in field to get to Expression Builder
 Report Label (Rework Queue Stats)
 Pop-up secondary spreadsheet for Categories (browse file)
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Frequencies (cont’d.)

• Add another Frequency (in Statistic module) to 
give a finer description of the Sealer states
 Will produce statistics on proportion of time Sealer is in 

each of its three possible states – Busy, Idle, and Failed
• Frequencies are not part of default Category 

Overview report – open Frequencies report from 
Project Bar (get a separate window for them)
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Results of Model 4-2

• Differ from those of Model 4-1 since this is a 
longer run, modeling assumptions are different
 All of which causes underlying random-number stream to 

be used differently (Chapter 12)
• Prep A/B didn’t change (other than run length and 

random variation) … need statistical analysis of 
simulation output (Chapters 6, 7, 12)

• Sealer is more congested (it now fails)
• Rework is less congested (50% higher staffing)
• Frequencies report suggests one rack suffices 

about 95% of the time, two racks all the time
 See text for discussion of Standard, Restricted Percents

ظتكم

يفكي
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Utilizations – Some Fine Points
• Two utilizations reported for each Resource

 Instantaneous Utilization is the time-average of the ratio of 
the number of units that are busy to the number of units 
that are scheduled

– By definition, counts periods when zero units are scheduled as 
zero-utilization periods

 Scheduled Utilization is the average number busy divided 
by the average number available

– No division-by-zero problem, assuming there were ever any units of 
the Resource scheduled at all (if not, it shouldn’t be in the model)

• Identical for fixed-capacity Resource
• Can differ for Resources on a variable Schedule

 If Resource capacity varies among several different positive 
values, it’s better to use Scheduled Utilization

 See text for discussion of issues and even finer points

تامادختسلاا

يروفلا مادختسلاا
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Model 4-3: Enhancing the Animation

• Get “Spartan” generic default animation for some 
things (queues, connector-animation movement)
 Usually sufficient for verification, validation

• Often want to customize, enhance it a bit
 More realism, impact

• Can pull animation away from model logic in 
model window
 Useful for big models, complex animation
 Set up Named Views for model logic, animation, or close-

ups of parts of animation
• Animation objects are connected to model logic

 Identifiers, physical location (Shift-drag to decouple)
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Changing Animation Queues

• Lengthen (click, drag, maybe hold shift) to “hold” 
more entities
 Simulation logic, results still OK even if animated queue 

overflows
• Rotate to re-orient for realism
• Change the “form” of the queue from Line (the 

default) to Point — fixed places for entities
 Double-click on the queue
 Select Type to be Point
 Click Points… button
 Successively click Add for points, then OK
 Drag them around on screen
 Check Rotate box to show entities turning
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Changing the Entity Pictures

• Earlier – used Entity data module to assign 
different Initial Pictures to different Entity Types

• Now – customize the list, or alter the pictures in it
 Edit > Entity Pictures
 Left column – names, pictures currently on the list
 Right column –picture libraries (.plb filename extension)
 Add a hand-drawn picture – Add button on left, name it in 

Value field at top, double-click on blank depressed button, 
then artwork (or paste in a copied graphics image)

– New name won’t appear in Entity data module until you type it there
 Edit an existing picture – double-click, artwork
 Copy a picture over from picture library
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Adding Resource Pictures
• Animate a Resource – Resource button        in 

animate toolbar – get Resource Picture 
Placement window

• Left column – default pictures for different 
Resource states
 Attach logically to a Resource by Identifier pull-down list
 Double-click to edit the artwork by hand, or paste in 

previously copied graphics images
 Seize area – where seizing entity will “reside”
 Multiple seize areas for multi-capacity Resources

• Right column – picture libraries (.plb files) – can 
copy over to selected (depressed) state pictures

• Accept window, cross hairs, click to place
 Resize, reposition later
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Adding Variables and Plots

• Variable animation – just show a value of 
something as a number, watch it change
 Variable object         from Animate toolbar
 Double-click, specify Expression to be shown (Expression 

Builder), and cosmetics
 Resize, reposition later

• Dynamic animated plots – discussed in Chapter 3
• Other animation objects from Animate toolbar

 Clock (TNOW), variety of formats
 Level (thermometer) animation
 Others discussed later



Adding Variables and Plots
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Model 4-4:  The Electronic Assembly 
and Test System with Part Transfers

• Generalize Model 4-3
• All part transfers now take 2 minutes (not instant) 

… want to model and animate
 Includes:

– Arriving parts to prep areas
– Departing parts to appropriate exit
– All internal part transfers

 Regardless of distance ... will fix this (unrealistic) 
assumption in Chapter 8

ايروف سيل
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New Arena Constructs

• Station – location where some process occurs
 Arrivals, manufacturing cells, departures
 Each Station given a unique name
 Can serve as an entry point for a section of model logic
 Station marker            represents a logical station in the 

flowchart/animation
• Station Transfer – entities move between Stations 

without direct connection
 Several different types – we’ll use Routes here, which allow 

for positive transfer time, but no other delays like “room” on 
the transitway or transporters

 Route paths represent Routes in the flowchart/animation
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Adding the Route Logic – From Arrival

• Stations and Station Transfers affect both the 
model logic and the animation

• Start with Model 4-3 … change to Model 4-4
• For incoming parts (A and B) delete connection 

from Assign modules to “Prep” Process modules
 Replace with Station/Route module pairs

– Station module (Advanced Transfer panel) – define entity’s current 
location

Module Name vs. Station Name

– Route module (Advanced Transfer panel) – send entity out
Route Time, Destination Station

 No direct connections exiting from the Route modules – 
Route module’s Destination Station Name defines that
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Adding the Remaining Route Logic

• Add Station modules for entry to each Prep area
 Station names are Prep A Station, Prep B Station, 

and are the destination stations for Routes after arrivals
• Process modules for Prep A, Prep B unchanged
• After prep, entities connected to Route module to 

send to next station (sealer)
 Don’t need a separate Station module for outgoing side

• Similar changes for rest of model
 Station modules for incoming parts into sealer, rework, 

each of three Record modules (entity exit points)
 Route modules for outgoing parts out of sealer inspection, 

rework inspection (two for each Decide module – pass/fail)
• Could run model now, get correct results … but 

no animation of transfers …
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Why Not Just Add Delays?

• Simpler approach than the above to getting the 
two-minute transfer times:
 Insert a Process module with Action = Delay for 2 minutes 

on each relevant connection
 Alternatively, use Delay module from Advanced Process 

panel
• Actually this would work fine from modeling, 

numerical-output viewpoints
• But it would not allow animation of part transfers, 

so we’ll proceed with the Stations and Routes
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Altering the Animation – Station 
Markers, Routes

• Add animation for Stations and Routes
• Station button     , Animate Transfer toolbar

 Attach Identifier to it from pull-down list of station names
 Get cross hairs, place (click) marker in animation
 Can place several station markers for the same logical 

station (to represent incoming, outgoing sides)
 Can drag station markers around later

• Route button      from Animate Transfer toolbar
 Options for appearance of entities as they travel the route
 Get cross hairs; click in origin, destination Station Markers

– Intermediate clicks for corners along the route
 Can drag around endpoints, corners later



Altering the Animation – Station Markers, Routes
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Altering the Animation – Entity Pictures

• Part B arrivals are in batches of four parts/batch
 But constant travel time to Prep B implies they  travel “on 

top of each other” so it looks like just one part B
 Try – change Route time from 2 to EXPO(2), see 

separation along the route
• Create illusion to animate the batch

 Assign module just after Part B Arrive
 Add assignment of Entity Picture to Picture.Batch B
 Edit > Entity Pictures to draw the new picture

– Copy Picture.Part B and rename it Picture.Batch B
– Double-click on picture, use Picture Editor to get four circles

 When batch arrives to Prep B, change to single circle
– Add Assign module after Prep B Arrival Station
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Input Analysis:  Specifying Model 
Parameters, Distributions

• Structural modeling:  what we’ve done so far
 Logical aspects — entities, resources, paths, etc.

• Quantitative modeling
 Numerical, distributional specifications
 Like structural modeling, need to observe system’s 

operation, take data if possible
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Deterministic vs. Random Inputs

• Deterministic:  nonrandom, fixed values
 Number of units of a resource
 Entity transfer time (?)
 Interarrival, processing times (?)

• Random (a.k.a. stochastic):  model as a 
distribution, “draw” or “generate” values from to 
drive simulation
 Transfer, Interarrival, Processing times
 What distribution?  What distributional parameters?
 Causes simulation output to be random, too

• Don’t just assume randomness away — validity
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Collecting Data

• Generally hard, expensive, frustrating, boring
 System might not exist
 Data available on the wrong things — might have to 

change model according to what’s available
 Incomplete, “dirty” data
 Too much data (!)

• Sensitivity of outputs to uncertainty in inputs
• Match model detail to quality of data
• Cost — should be budgeted in project
• Capture variability in data — model validity
• Garbage In, Garbage Out (GIGO)
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Using Data:
Alternatives and Issues

• Use data “directly” in simulation
 Read actual observed values to drive the model inputs 

(interarrivals, service times, part types, …)
– Arena ReadWrite module ... see Model 10-2

 All values will be “legal” and realistic
 But can never go outside your observed data
 May not have enough data for long or many runs
 Computationally slow (reading disk files)

• Or, fit probability distribution to data
 “Draw” or “generate” synthetic observations from this 

distribution to drive the model inputs
 We’ve done it this way so far
 Can go beyond observed data (good and bad)
 May not get a good “fit” to data — validity?
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Fitting Distributions to Data
with the Arena Input Analyzer

• Assume:
 Have sample data:  Independent and Identically Distributed 

(IID) list of observed values from the actual physical system
 Want to select or fit a probability distribution for use in 

generating inputs for the simulation model
• Arena Input Analyzer

 Separate application, also accessible via Tools menu in 
Arena

 Fits distributions, gives valid Arena expression for 
generation to paste directly into simulation model
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Fitting Distributions to Data
with the Arena Input Analyzer (cont’d.)

• Fitting = deciding on distribution form 
(exponential, gamma, empirical, etc.) and 
estimating its parameters
 Several different methods (Maximum likelihood, moment 

matching, least squares, …)
 Assess goodness of fit via hypothesis tests

– H0: fitted distribution adequately represents the data
– Get p value for test (small = poor fit)

• Fitted “theoretical” vs. empirical distribution
• Continuous vs. discrete data, distribution
• “Best” fit from among several distributions
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Data Files for the Input Analyzer
• Create the data file (editor, word processor, 

spreadsheet, ...)
 Must be plain ASCII text (save as text or export)
 Data values separated by white space (blanks, tabs, 

linefeeds)
 Otherwise free format

• Open data file from within Input Analyzer
 File > New or
 File > Data File > Use Existing or 
 Get histogram, basic summary of data
 To see data file:  Window > Input Data

• Can generate “fake” data file to play around
 File > Data File > Generate New



Fitting Distributions to Data
with the Arena Input Analyzer
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The Fit Menu

• Fits distributions, does goodness-of-fit tests
• Fit a specific distribution form

 Plots density over histogram for visual “test”
 Gives exact expression to Copy and Paste (Ctrl+C, Ctrl+V) 

over into simulation model
 May include “offset” depending on distribution
 Gives results of goodness-of-fit tests

– Chi square, Kolmogorov-Smirnov tests
– Most important part:  p-value, always between 0 and 1:

Probability of getting a data set that’s more inconsistent with the fitted distribution 
than the data set you actually have, if the the fitted distribution is truly “the truth”

“Small” p (< 0.05 or so):  poor fit (try again or give up)
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The Fit Menu (cont’d.)

• Fit all of Arena’s (theoretical) distributions at 
once
 Fit > Fit All or
 Returns the minimum square-error distribution

– Square error = sum of squared discrepancies between histogram 
frequencies and fitted-distribution frequencies

– Can depend on histogram intervals chosen:  different intervals can 
lead to different “best” distribution

 Could still be a poor fit, though (check p value)
 To see all distributions, ranked: Window > Fit All Summary 

or
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The Fit Menu (cont’d.)

• “Fit” Empirical distribution (continuous or 
discrete):  Fit > Empirical
 Can interpret results as a Discrete or Continuous 

distribution
– Discrete:  get pairs (Cumulative Probability, Value)
– Continuous:  Arena will linearly interpolate within the data range 

according to these pairs (so you can never generate values outside 
the range, which might be good or bad)

 Empirical distribution can be used when “theoretical” 
distributions fit poorly, or intentionally
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Some Issues in Fitting Input 
Distributions

• Not an exact science — no “right” answer
• Consider theoretical vs. empirical
• Consider range of distribution

 Infinite both ways (e.g., normal)
 Positive (e.g., exponential, gamma)
 Bounded (e.g., beta, uniform)

• Consider ease of parameter manipulation to 
affect means, variances

• Simulation model sensitivity analysis
• Outliers, multimodal data

 Maybe split data set (see textbook for details)
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No Data?

• Happens more often than you’d like
• No good solution; some (bad) options:

 Interview “experts”
– Min, Max:  Uniform
– Avg., % error or absolute error:  Uniform
– Min, Mode, Max:  Triangular

Mode can be different from Mean — allows asymmetry

 Interarrivals — independent, stationary
– Exponential— still need some value for mean

 Number of “random” events in an interval:  Poisson
 Sum of independent “pieces”:  normal
 Product of independent “pieces”:  lognormal
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Cautions on Using Normal Distributions

• Probably most familiar distribution – normal “bell 
curve” used widely in statistical inference

• But it has infinite tails in both directions … in 
particular, has an infinite left tail so can always 
(theoretically) generate negative values
 Many simulation input quantities (e.g., time durations) must 

be positive to make sense – Arena truncates negatives to 0
• If mean  is big relative to standard deviation , 

then P(negative) value is small … one in a million
• But in simulation, one in a million can happen
• Moral – avoid normal distribution as input model
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Nonstationary Arrival Processes

• External events (often arrivals) whose rate varies 
over time
 Lunchtime at fast-food restaurants
 Rush-hour traffic in cities
 Telephone call centers
 Seasonal demands for a manufactured product

• It can be critical to model this nonstationarity for 
model validity
 Ignoring peaks, valleys can mask important behavior
 Can miss rush hours, etc.

• Good model:  Nonstationary Poisson process
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Nonstationary Arrival Processes (cont’d.)

• Two issues:
 How to specify/estimate the rate function
 How to generate from it properly during the simulation

• Several ways to estimate rate function — we’ll 
just do the piecewise-constant method
 Divide time frame of simulation into subintervals of time 

over which you think rate is fairly flat
 Compute observed rate within each subinterval
 In Arena, must convert to expected number of arrivals per 

hour on subintervals of time that need not be of one-hour 
length

– Want expected 45 arrivals in a half hour; specify rate = 90 per hour

• Example:  Model 5-2 in Chapter 5
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Multivariate and Correlated Input Data

• Usually we assume that all generated random 
observations across a simulation are 
independent (though from possibly different 
distributions)

• Sometimes this isn’t true:
 A “difficult” part requires long processing in both the Prep 

and Sealer operations
 This is positive correlation

• Ignoring such relations can invalidate model
• See textbook for ideas, references
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What We’ll Do ...

• Explore lower-level modeling constructs
• Model 5-1:  Automotive maintenance/repair shop

▪ Multi-way decisions, Sets, Variables, Expressions, 
Submodels, Duplicating entities, Holding entities

▪ Terminating vs. steady-state simulations
• Debugging
• Model 5-2:  Enhanced automotive shop model

▪ Sets and Resource logic, nonstationary arrival process
• Model 5-3:  An (s, S) inventory simulation

▪ Built exclusively via SIMAN Blocks, Elements



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 3 of 68

Model 5-1: An Automotive Maintenance 
and Repair Shop

• New three-bay suburban satellite facility
• Appointments taken up to three days in advance
• No appointments taken for current day
• Number of calls per day ~ Poisson with mean 25 

calls/day
▪ 55% of calls schedule appointment for the next day
▪ 30% for two days out
▪ 15% for three days out

• If no appointment is available on the desired day, 
there’s a 90% chance that the caller will want to 
schedule for the following day
▪ Other 10% just go away



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 4 of 68

An Automotive Repair and
Maintenance Shop (cont’d.)

• 80% leave vehicle for service, come back later
▪ Other 20% wait at the shop

• Wait customers given approximate wait time
▪ Estimated service time (Book Time) + Allowance (1 hour)

• Limit of five wait customers per day
• Book Time ~ 44 + 90*BETA(2, 3) minutes
• Actual service time ~ GAMM(Book Time/1.05, 

1.05) minutes
• Maximum of 24 hours (Book Time) scheduled per 

day (three bays, eight hours each)
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Costs, Revenues

• Capital and labor cost = $45/hour/bay
▪ 40-hour work week

• Revenue from customer = $78/hour (charged for 
Book Time, not actual time)

• Overtime costs $120/hour
▪ Maximum of three hours/day/bay

• If service can’t be completed that day, vehicle is 
held over night and customer gets free loaner car
▪ Loaner car costs the shop $35/day

• If service isn’t started that day, customer takes 
car home and returns next day – no cost to shop
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System Performance

• Daily profit
• Daily Book Time
• Daily actual service time
• Daily overtime
• Daily number of wait appointments not completed 

on time
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New Modeling Issues
• Service System – not manufacturing

▪ But can use same modeling capabilities
• Multiple-way decisions

▪ Appointment entities go to one of five wait queues based 
on day of appointment

▪ Capability available in Decide module
• Sets

▪ Groups of similar objects
▪ Reference by a common set name and index into the set 

(subscript)
– Can also be referenced via their original name
– Arena sets are ordered

▪ Service bays will be modeled as a set of resources
– Also use sets for entity pictures and appointment queues

▪ Define via Sets data module
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New Modeling Issues (cont’d.)

• Variables and Expressions
▪ Can be referenced in model by name
▪ Can be one- or two-dimensional arrays, indexed by one or 

two integers
▪ User-defined Variables

– Store some numerical value (not a formula)
– Can be initialized in Variable data module
– Can be used, reassigned during the simulation run by any entity

▪ User-defined Expressions
– A name defined by a mathematical expression
– This name can be referenced anywhere in the model
– Can use constants, Variables, Attributes, system state variables, 

values from distribution – connected via mathematical operations
Can use Expression Builder to help define

– Defined in Expression data module (Advanced Process panel)
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New Modeling Issues (cont’d.)

• Submodels
▪ Partition simulation model into several smaller submodels

– Can link them together, more manageable pieces

▪ Just like a normal model view within a submodel
▪ Submodels can also contain further submodels, etc. – 

hierarchical structure
▪ Submodels can be externally connected to other modules 

or submodels
▪ Navigate panel in Project Bar shows submodels, under 

Top-Level Model
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New Modeling Issues (cont’d.)

• Duplicating entities
▪ “Cloning” an entity
▪ Entities often used for control
▪ Do this via Separate module

• Holding entities
▪ Hold entities in a queue until

– A signal is sent by another entity
– A system condition exists

▪ Hold and Signal modules (Advanced Process panel)
▪ Here, used to hold customers until the day of scheduled 

service
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Animation Requirements

• No entity movement
• Can still display queues
• Appointments

▪ Number
▪ Type
▪ Book Time hours per day

• Bay resources
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System or Simulation Type

• Terminating
▪ Known starting and stopping conditions – part of model
▪ Time frame is known (and finite)

• Steady-State
▪ Initial conditions are not always well defined
▪ No defined stopping condition (theoretically infinite)
▪ Interested in system response over the long run

• Automotive repair model
▪ Starting and ending times known each day

– Some vehicles can be held over from one day to the next
– But we’ll simulate for 20 days (approximately a working month)

▪ Treat the system as terminating
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Arena Modeling Panels

• Basic Process panel
▪ Highest level of modeling

• Advanced Process panel
▪ More detailed (and different) modeling capabilities

• Advanced Transfer panel
▪ Material-handling, entity-movement capabilities

• Blocks, Elements panels
▪ Lowest level of modeling capabilities – the underlying 

SIMAN simulation language itself
▪ Other panels are created using modules from these panels
▪ Occasionally needed, but not very often
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Building the Model

• Defining the Data
• Submodel Creation
• Divide model in sections or submodels

▪ Generate Appointment Calls
▪ Make Appointment
▪ Service Activity
▪ Update Performance Variables
▪ Control Logic

• We’ll discuss each of these in turn
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Simulation Replication Data

• Project replication parameters
▪ Run/Setup dialog – Replication Parameters tab
▪ 10 Replications of 20 twelve-hour days each
▪ Four options for Initialization Between Replications:

– Initialize system (yes), initialize statistics (yes): selected
10 independent, identical replications – vehicles not carried over at end of month
Reports for each month separately, and aggregated

– Initialize system (yes), initialize statistics (no)
10 independent, identical replications – vehicles not carried over at end of month
Cumulative summary reports (month 1, months 1-2, months 1-3, …, months 1-10)

– Initialize system (no), initialize statistics (yes)
10 continuous months – vehicles carried over at end of each month
Reports are by replication (month)

– Initialize system (no), initialize statistics (no)
10 continuous months – vehicles carried over at end of each month
Cumulative summary reports (month 1, months 1-2, months 1-3, …, months 1-10)
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Schedule Data

• Schedules
▪ Enter into Schedule data module
▪ 3 schedules required, one for each of the service bays

But they’re identical so we need define only one, and use it for all three bays

▪ 12-hour schedule
– One-hour down time at the beginning (take appointments, etc.)
– Eight-hour working day
– Three-hour overtime

▪ Use Graphical schedule editor
▪ Use Edit via Dialog (or Edit via Spreadsheet) if you need 

trailing zeros in the capacity to fill out the cycling time 
window, or if you need variables in the schedule
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Resource Data

• Define resources
▪ Use Resource data module
▪ Three resources – one for each service bay
▪ Enter Schedule Name

– Use Preempt option for Schedule Rule to ensure all work stops at 
the end of the three-hour overtime period
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Sets Data

• Use Set data module (Basic Process panel)
• Develop one Resource set

▪ Service bays – Bays
• Develop two entity picture sets

▪ Customers
▪ Vehicles

• Develop one queue set 
▪ Use Advanced Set data module (Advanced Process panel)
▪ First, define appointment queues – Queue data module
▪ Then, define Appointment Queues set









Develop two entity picture sets
▪

 Customers

▪

 Vehicles



• Develop one queue set
▪

 Use Advanced Set data module (Advanced Process panel)

▪

 First, define appointment queues – Queue data module

▪

 Then, define Appointment Queues set
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Variable Data

• Six control variables
▪ Day – current day 

– initialized to 4
▪ Day Load – current number of appointment hours per day

– arrayed variable, 5 rows
▪ Max Load – maximum appointment hours per day

– initialized to 24
▪ Max Wait – maximum number of wait customers per day

– initialized to 5
▪ Wait Load – current number of wait jobs per day

– arrayed variable, 5 rows
▪ Calls Per Day – average number of calls per day

– initialized to 25
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Variable Data (cont’d.)

• Five output variables
▪ Day Book Time – total book time hours processed
▪ Day Actual time – total actual service time processed
▪ Day Overtime – total overtime hours
▪ Day OT – total number of vehicles held over night
▪ Day Wait Late – total number of late wait jobs

• Four control-logic variables
▪ Work Day – the current work day
▪ Day Start Time – starting time of current day
▪ Day End Time – ending time of current day
▪ Wait Allowance – wait allowance time

– Initialized to 1 (hour)
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Expression Data

• Three expressions
▪ Book Time Expression – returns the service book time 

(in hours)
▪ Wait Priority Expression – returns 1 for wait 

customer, 2 for leave customer
▪ Actual Service Time Expression – returns the 

actual service time based on the Book Time
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Output Data

• Use Statistic data module
• Five output values

▪ Daily Book Time – daily average book time processed
▪ Daily Actual Time –  daily average actual time 

processed
▪ Daily Overtime –  daily average overtime
▪ Daily Late Wait Jobs – daily average number of late 

wait jobs
▪ Daily Profit – average daily profit

• All are of type Output, so will be computed only at 
the end of the simulation
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Submodel Creation

• Object/Submodel/Add Submodel menu option
(or     ) to create a submodel … we’ll use five 
submodels
▪ Define (right-click, then Properties)

– Name
– Number of entry, exit points (could be 0 if there’s no flow interaction)

▪ Move between submodels: Navigate panel, Named Views, 
or mouse

– Double-click on a submodel to open it
– When in a submodel, right-click in an empty place, then Close 

Submodel to go up
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Generate Appointment Calls Submodel

• Generates the daily appointment calls
• No entry point – one exit point
• First day of simulation is different

▪ Generate three duplicates to make appointments for the 
initial three days
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Submodel Logic
• Create one entity each morning (at just > 0)
• Increment Day & set Call Number attribute to 1
• If start of replication (TNOW < 1)

▪ Day was initialized to 4 (Thurs.) so it’s now 5 (Fri.)
▪ Create three duplicate entities for next Mon., Tues., Wed. 

appointments
– Send the three duplicates immediately to *** below to schedule 

initial 3 days out (Mon., Tues., Wed.)
– Delay original entity (representing calls coming in today) a bit so 

duplicates will do the future scheduling first, and reset Day back to 1 
for calls coming in on Monday

• ***
▪ Assign number of calls (N) for this day
▪ If Day is 6 (Saturday), set it back to 1 (Monday)
▪ Create N - 1 duplicate entities
▪ Assign appointment attributes
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Generate Appointment Calls Submodel
 (cont’d.)

• Create a single entity each day (every 12 hours)
• Assign Number of Calls for this day
• Increment Day variable
• Create duplicates (Number of Calls – 1)

▪ Separate module for “cloning”
• Assign call attributes (after cloning to make them 

distinct)
▪ Day Inc – first feasible appointment day out (1, 2, or 3) 
▪ Priority – wait (1) or leave (2)
▪ Book Time
▪ Try Day – first day of week customer wants appointment
▪ Entity.Picture – from picture set Customers

• Entities exiting this submodel are individual calls
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Make Appointment Submodel
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Make Appointment Submodel (cont’d.)

• One entry point
▪ From Generate Appointment Calls Submodel 

• Five exit points
▪ Corresponds to five appointment days

• Arriving entity is a customer call wanting to make 
an appointment

• Contains checks to see if customer can make an 
appointment
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Make Appointment Submodel (cont’d.)

• Check for valid Try Day value
▪ If not 1 through 5, subtract 5 from it

• Check for room in schedule
▪ Is Book Time + Day Load(Try Day) <= Max Load?
▪ If not, check for next day

• Check for Wait job
▪ If this is a wait job, check for room

– Is Wait Load(Try Day) < Max Wait?
– If not, check for next day
– Otherwise, increase Wait Load variable by 1
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Make Appointment Submodel (cont’d.)

• Assign Job
▪ Increase Variable Day Load(Try Day) by Book Time

• Send to job queue
▪ Decide module based on appointment day
▪ Send to one of five exit points
▪ Error trap should never be taken

• Appointment not possible – check for next day
▪ If Day Inc variable >= 3, no next day (dispose)
▪ Decide module with 90% chance of next day

– Increment Day Inc and Try Day variables and start over
– Otherwise,  dispose
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Service Activity Submodel
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Service Activity Submodel (cont’d.)

• Five entry points
▪ Corresponding to five appointment days

• One exit point
▪ Service complete, send to Update Performance Variables 

submodel
• Arriving entity is a customer appointment
• Holds entity until service day
• Actual vehicle service
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Service Activity Submodel (cont’d.)

• Arriving entity enters customer appointment 
queue
▪ One of five Hold modules
▪ Entities are released based on a signal sent from the 

Control Logic submodel
– Signal value of variable Day is sent at the start of each work day 

• Assign new picture from picture set Vehicle
▪ Based on service type – attribute Priority

• Assign current time to attribute Arrive Time



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 34 of 68

Service Activity Submodel (cont’d.)

• Seize service bay
▪ From resource set Bays

• Assign service start time to attribute Start Time
• Delay for actual service time
• Release service bay
• Exit submodel
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Update Performance Variables
Submodel
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Update Performance Variables
Submodel (cont’d.)

• One entry point
▪ Completed service entity

• No exit points
• Updates the performance variables
• Disposes of entity



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 37 of 68

Update Performance Variables
Submodel (cont’d.)

• Check for same-day service – was job started on 
a previous day?
▪ Same day

– Update Day Book Time and Day Actual Time variables
– Check for overtime

Overtime – update Day Overtime variable

– Check for wait job
If yes, check for wait job on time

» If yes, dispose; if no, update Day Wait Late variable
If no, dispose 

▪ Not same day
– Calculate days held over – attribute Days Held
– Update Day Book Time, Day Actual Time, Day Overtime, 

and Total OT variables
– Repeat wait job check (above)
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Control Logic Submodel

• No exit or entry points
• Causes current day’s appointments to be 

released for service
• Updates control variables
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Control Logic Submodel (cont’d.)

• Create control entity
▪ One every 12 hours – one each day
▪ Offset first creation by 0.9999 hours (see text for details)

• “Broadcast” Signal = current value of variable 
Day
▪ Causes the day’s appointments to be released for service

• Reset Wait Load and Day Load variables for 
current day to zero

• Update Work Day, Day Start Time, and Day 
End Time variables

• Dispose of control entity



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 40 of 68

Finding and Fixing Model Errors

• Arena picks up “simple” errors in Check phase, 
and leads you to them via Find and Edit buttons 
in Errors/Warnings windows
▪ Undefined variables, attributes, resources
▪ Unconnected modules
▪ Duplicate module names
▪ Typos
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Finding and Fixing Model Errors (cont’d.)

• Other kinds of errors are more complex, can’t be 
detected without trying to run
▪ Options on Run Interaction toolbar or on Run menu
▪ Only mention capabilities here; see text for details

• Run Controller
▪ Command-driven window to control, display details about 

model operation and underlying SIMAN code
• Highlight active module

▪ Highlights the active module during the simulation run
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Finding and Fixing Model Errors (cont’d.)

• Layers
▪ Gives control over what you see during the simulation run

• Break on Module; Break
▪ Stop run when entity hits a selected module, at a specific 

time, or when a selected entity is about to become active
• Watch

▪ Select expressions to display in a window as model runs
• Look at reports when model is running or paused

▪ Remember to close reports windows
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Animating the Automotive Shop Model

• No “normal” entity movement
▪ Entities jump from queue to queue to resource

• Appointment and service-bay queues
▪ Queue button from Animate toolbar

• Appointment queue variables
▪ Book Time hours
▪ Number of appointments
▪ Number of Wait appointments

• Resource animation
▪ Resource button from Animate toolbar
▪ Take pictures from libraries (.plb files), different states

• Add various text annotations, boxes, etc.



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 44 of 68

Animating the Automotive Shop Model
(cont’d.)

• Created digital clock “by hand” (details in text)
▪ Could have used ready-made animated clock

– Only because day is 12 hours

• Current day of week 
▪ Global variable
▪ Use Global button from Animate toolbar
▪ Trigger value based on variable Day
▪ Text picture contains week day name

– Monday through Friday
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Model 5-2:
Enhancing the Automotive Shop Model

• New Elements
▪ Not all jobs can be done in all bays

– All jobs can be done in Bays 2 & 3 (60%)
– Bay 1 can only handle a subset (40%)

▪ Not all customers arrive on time
– 60% to 70% arrive on time (uniform distribution)

▪ Some customers never show up
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New Modeling Issues

• Sets
▪ Overlapping Resource Sets

– Set Bays contains Resources Bay 1, Bay 2, and Bay 3
– Set Bays 2 or 3 contains Resources Bay 2 and Bay 3

• Resource Logic
▪ Multiple queues requesting the same resource

– Seize priority
– Tie breaker is entity waiting the longest
– Shared queues
– See text for details
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New Modeling Issues (cont’d.)

• Nonstationary Poisson arrival process
▪ Arrivals occur one at a time and are independent of one 

another
▪ Expected rate varies over time (would be constant for a 

stationary Poisson process)
▪ Generation capability built into Create module

– Type = Schedule
– Specify arrival-rate function in Schedule model
– Limited to piecewise-constant  arrival-rate functions

▪ Used  for late customer arrivals
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Changes to Model 5-1

• Add/change logic to account for difference in 
service bay capabilities

• Add/change logic for new customer arrival 
process
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Service-Bay Logic Changes

• Generate Appointment Calls submodel
▪ Add assignment for Job Type attribute

– 1 if job can be serviced in any bay
– 2 if only bays 1 or 2
– Generate via DISC(0.60,1, 1.0,2)

• Change picture set Vehicle
▪ Put yellow doors on new job types (see text for details)
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Service-Bay Logic Changes (cont’d.)

▪ Modify logic in Service Activity submodel
▪ Assign new picture

– Vehicle(Priority + (AINT(Job Type/2))*2)



Simulation with Arena, 3rd ed. Chapter 5 – Modeling Detailed Operations Slide 51 of 68

Service-Bay Logic Changes (cont’d.)

• Insert Decide module 
▪ Direct entity based on attribute Job Type
▪ If Job Type = 1, send to existing logic
▪ If Job Type = 2, send to new logic

– New logic copy of existing logic
– Change resource set to Bays 2 or 3

• Change queue rankings
▪ Queue data module
▪ Lowest Attribute Value First

– Based on the attribute Priority
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Service-Bay Logic Changes (cont’d.)

• Change seize priorities
▪ Existing Logic: (Priority*10) +1
▪ New logic: Priority*10

• Resulting queue priorities
▪ Priority 1 and Job Type 1 with a Seize priority of 11
▪ Priority 2 and Job Type 1 with a Seize priority of 21
▪ Priority 1 and Job Type 2 with a Seize priority of 10
▪ Priority 2 and Job Type 2 with a Seize priority of 20
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Customer Arrival Process

• Change Control Logic submodel
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Customer Arrival Process (cont’d.)

• On-time customers
▪ Insert new Assign module

– Variable On Time
ANINT( UNIF( 0.60 , 0.70) * NQ(Appointment Queues( Day) ) )

– Variable Late
NQ(Appointment Queues( Day) ) - On Time

– Variable Total Late
Total Late + Late

▪ Change Signal module
– Set signal Limit to variable On Time
– Only the on-time customers are released from appointment queue
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Customer Arrival Process (cont’d.)

• Late-arriving customers
▪ Arrive in first two hours after start of service
▪ Not all customers show up for appointment
▪ Data in 15-minute time periods (8 periods)
▪ Use Create module with arrival Type of Schedule

• Add new schedule
▪ Late Arrival Schedule
▪ 48 time periods (12 hours)
▪ First four and last 36 have zero arrival rate
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Customer Arrival Process (cont’d.)

• Late arrival logic
▪ Create late arrival entity

– Start one hour into day

▪ Check appointment queue
– Entity in queue, signal with Limit of 1 to release customer
– No entity in queue, dispose of entity

• No-show customer logic
▪ Create control entity three hours into day
▪ Check appointment queue

– Entity in queue
Remove first entity and send back to check

– No entity in queue
Dispose of entity
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Model 5-3:
An (s, S) Inventory Simulation

• Different kind of model – not queueing
• Will use modules from the Blocks and Elements 

panels exclusively – SIMAN simulation language
▪ Doing this mostly just to demonstrate this capability
▪ Could be done with higher-level panels we’ve been using

• Company carries a single discrete item (widgets) 
in inventory

•I(t) = inventory level (an integer) at time t days 
past the beginning of the simulation; I(0) = 60

• Run simulation for 120 round-the-clock days
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Customer Demands Against Inventory

• Customer interarrival times ~ exponential with 
mean 0.1 day (round the clock)
▪ First arrival not at time 0 but after an interarrival time past 0

• Demand size is discrete random variable
▪ 1, 2, 3, 4 with respective probabilities

0.167, 0.333, 0.333, 0.167
• If enough items are physically on hand in 

inventory to satisfy a demand, customer gets 
demand and leaves

• If demand > number of items on hand, customer 
gets whatever is there and the rest of the demand 
is backlogged (I(t) becomes negative)
▪ If I(t) was already negative, it just goes more negative
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Inventory Review, Replenishment

• “Take inventory” at beginning of each day
▪ So at exactly times 0, 1, 2, ..., 119 (not 120 ... see below)
▪ Two managerially-chosen constant integers s = 20 and

S = 40 (must have s < S if we change these values)
▪ If I(t) ≥ s, do nothing until next inventory evaluation exactly 

one day later
▪ If I(t) < s, order S – I(t) items from supplier (order “up to” S)
▪ Order does not arrive instantly from supplier, but after a 

delivery lag (a.k.a. lead time) ~ UNIF(0.5, 1.0) day, so 
sometime during the last half of the day of ordering

– In the meantime, inventory level could fall further from additional 
demands, so inventory level will not necessarily pop up to S when 
the order arrives, but to something less than S
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Cost Structure

• Average ordering cost per day
▪ When an order is placed, incur a fixed cost of $32, plus an 

incremental cost of $3 per item ordered
▪ If no order is placed at the beginning of a month, there’s no 

ordering cost, not even the fixed cost
▪ At end of simulation, divide total of ordering costs by 120

• Average holding cost per day
▪ Whenever I(t) > 0, incur $1 per day per item on hand
▪ Average holding cost = 

• Average shortage cost per day
▪ Whenever I(t) < 0, incur $5 per day per item in backlog
▪ Average shortage cost =
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Cost Structure (cont’d.)

• During periods when I(t) = 0 there’s neither 
holding nor shortage cost incurred

• Overall performance measure
 = Average total cost per day
 = sum of average ordering, holding, and 
  shortage costs per day

• Don’t evaluate inventory at time 120
▪ We might order and incur an ordering cost then, but order 

will never arrive
▪ We’ll fudge this, but an Exercise asks you to do it right
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Data Structure

• Use Blocks, Elements panels exclusively
▪ Even for Variables, Expressions, Attributes, Entities, statistics collection, 

and run control

• Variables Element (initialized, or default to 0 initially)
▪ Inventory Level = I(t), changes during run, initialized to 60
▪ Little s = s = 20
▪ Big S = S = 40
▪ Total Ordering Cost accumulator
▪ Setup Cost = 32
▪ Incremental Cost = 3
▪ Unit Holding Cost = 1
▪ Unit Shortage Cost = 5
▪ Days to Run = 119.9999 (The Fudge)
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Data Structure (cont’d.)

• Expressions element
▪ Define Interdemand Time, Demand Size, Evaluation 
Interval, Delivery Lag

– Note cumulative probabilities in DISC function for Demand 
Size

• Attributes, Entities elements
▪ Just to define these objects

• Project, Replicate elements
▪ Similar to Run > Setup

• DStats element
▪ To ask for accumulation of integrals for total holding, 

shortage costs
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Data Structure (cont’d.)

• Outputs element
▪ Two entries, both of Data type “Output” so that they’re 

executed only at end of run, and reported
▪ Avg Ordering Cost computed
▪ Avg Total Cost added up

– OVALUE returns most recent value
– DAVG returns time-persistent average
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Logic for Customer Demands
Against Inventory

• Create block for arrival
▪ Entity Type is Customer
▪ Uses Interdemand Time Expression
▪ First Creation after an Interdemand Time

• Assign block to decrement Inventory Level by 
a Demand Size
▪ Demand Size was defined as an Expression
▪ Backlogging naturally happens

• Dispose block for customer exit
▪ If backlogged, is accounted for automatically in the (simple) 

definition and tracking of Inventory Level
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Inventory Evaluation

• Create block for Inventory Evaluator entities
▪ First Creation at time 0 – evaluate inventory at start of run
▪ Interval is Evaluation Interval, defined as Expression

• Branch block – somewhat like Decide module
▪ To determine whether to place an order now
▪ Add “branches,” each evaluated as true or false
▪ Clone of incoming entity sent out along each “true” branch, 

but at most Max Number of Branches will be sent out
– So we set Max Number of Branches to 1 (default is )

▪ First branch of type “If” – if “true” we want to order
▪ Second branch of type “Else” – if “true” it means that the 

first branch was “false” so we don’t order – just Dispose
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Placing an Order

• If we exit the Branch block via the top “If” branch, 
it must be that I(t) < s so we want to order up to S

• Assign block
▪ Define Order Quantity Attribute

– Could have made this a Variable in this model with these 
parameters, but it’s more general for it to be an Attribute ... why??

▪ Increment Total Ordering Cost Variable
• Delay block for Delivery Lag
• Assign block to increment Inventory Level by 

the Order Quantity
• Dispose block
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Animation

• Plot with separate “in the black” and “in the red” 
curves
▪ If in backlog, red curve will be plotted in negative direction 

due to its Expression
• Pair of Level (“thermometer”) animations

▪ Fill Direction for “in the red” is Down
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What We’ll Do ...

• Model 5-1:  Simple call center
▪ Lower-level modeling, Advanced Process panel
▪ Three-way decisions, Variables, Expressions, Storages
▪ Blocks panel
▪ Terminating vs. steady-state operation
▪ Logical (“fake”) entities
▪ Terminating Condition in Run > Setup

• Model 5-2:  Enhanced call center
▪ Nonstationary Poisson arrival process
▪ Sets – Resource, Counter
▪ New Statistic data module Types

– Counter, Time Persistent
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What We’ll Do ... (cont’d.)

• Model 5-3:  Enhanced call center with more 
output performance measures
▪ New Statistic data module Type

– Output

▪ Additional variable resources – look at staffing levels
• Model 5-4:  (s, S) inventory

▪ Not queueing
▪ Choose to use low-level Blocks, Elements panels (SIMAN)

– Can be done with higher-level panels









Simulation with Arena, 4th ed. Chapter 5 – Modeling Detailed Operations Slide 4 of 51

Model 5-1:  Simple Call Center
Setup
• One phone number for customers to call in to

▪ 26 trunk lines, one needed for each call (incoming or 
outgoing, talking or on hold)

▪ Arriving call finding no free trunk lines gets busy signal, 
goes away

– Count number of such rejected calls

• Calls arrive with interarrivals ~ EXPO (0.857) min.
▪ First call arrives at time 0

• Three incoming call types
▪ Initial recording to decide ~ UNIF (0.1, 0.6) min.
▪ Tech support (76%), sales (16%), order status (8%)



Simulation with Arena, 4th ed. Chapter 5 – Modeling Detailed Operations Slide 5 of 51

Model 5-1:  Simple Call Center
Setup (cont’d.)

• Tech-support calls
▪ For product type 1 (25%), 2 (34%), or 3 (41%)
▪ Needs qualified tech-support person

– Two for type 1, three for type 2, three for type 3
No crossover to another type ... change in Model 5-2

– Separate FIFO queues for each type
– Conversation time ~ TRIA (3, 6, 18) min. for all types

▪ Then leaves system
• Sales calls

▪ All the same
▪ Four sales staff, all the same

– One FIFO queue feeding all sales staff
▪ Conversation time ~ TRIA (4, 15, 45)
▪ Then leaves system



Simulation with Arena, 4th ed. Chapter 5 – Modeling Detailed Operations Slide 6 of 51

Model 5-1:  Simple Call Center
Setup (cont’d.)

• Order-status calls
▪ All the same
▪ Handled automatically by phone system

– No limit on number in process at a time, except for trunk-line limit

▪ “Conversation” time ~ TRIA (2, 3, 4)
▪ After “conversation,” 15% of callers opt to talk to a person

– Routed to sales staff
– Sales calls have higher priority (non-preemptive)

• Center receives calls 8am – 6pm
▪ Must terminate arrival process at 6pm
▪ Operate past 6pm if necessary to “flush out” all calls
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Model 5-1:  Simple Call Center
Setup (cont’d.)

• Output performance measures
▪ Number of calls attempted, rejected, completed
▪ By call type – total time in system
▪ By resource – time on hold, number of calls on hold
▪ Resource utilization – personnel, trunk lines

• Terminating or steady-state
▪ Time frame of interest for each replication

– Terminating – specific starting, stopping conditions (this model)
Stopping conditions could be of several forms – fixed time, count, condition (here)

– Steady-state – output performance measures are a limit as 
simulated time → 

– Choice usually depends on intent of study, not on model logic
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Model 5-1:  Simple Call Center
Modeling Panels
• Basic Process

▪ Highest, fastest modeling level, usually the place to start
• Advanced Process

▪ Smaller building elements, other functions, more detail
• Advanced Transfer

▪ Entity movement, material handling
• Blocks, Elements

▪ Lowest modeling level, SIMAN simulation language
▪ Repeats some capabilities of higher-level panels
▪ Some functions available only here

• Other special-purpose panels
▪ License-dependent
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Model 5-1:  Simple Call Center
Data Structure
• Re-use data in several places

▪ Define once, global to whole model
▪ Redefine once – modeling generality, user efficiency

• Arena Variables
▪ Store numbers (not formulas)
▪ Define, initialize in Variable data module (Basic Process)
▪ Can change during run (Assign module, other ways)
▪ Scalar, 1-d array (vector), 2-d array (matrix)

• Arena Expressions – generalize Variables
▪ Store formulas (as well as numbers)

– Use math ops, numbers, random variates, Attributes, Variables, ...
▪ Define in Expression data module (Advanced Process)
▪ Scalar, 1-d array (vector), 2-d array (matrix)
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Model 5-1:  Simple Call Center
Arrivals, Direct to Service
• Create attempted calls

▪ Entity type Incoming Call, change later
▪ Max Arrivals = MaxCalls, Variable initialized to 999999

– At 6pm (time 600 minutes) change this to 1 to cut off arrivals ... later

• Entity data module
▪ Incoming Call Entity Type already there
▪ For Initial Picture, select Picture.Black Ball

• Record module for an attempted call
▪ Add 1 to Counter Name Attempted Calls
▪ Results – Category Overview report, User Specified

More detailed description – mouse over 
modules, read Data Tips that pop up
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Model 5-1:  Simple Call Center
Arrivals, Direct to Service (cont’d.)

• Decide module – Trunk Line Available?
▪ Type = 2-way by Condition

– Select (logical) Expression for “If”
NR() is number of units of that resource that are busy now
MR() is number of units of that resource that exist now 

▪ False – Record rejected call counter, Dispose
▪ True:

– Seize a unit of Trunk Line Resource – Release later
Resources data module for Trunk Line and other Resource levels

– Increment Variable Total WIP for number of active calls
Used in stopping rule at or after 6pm to sense if system is empty

– Store module to enable entity animation during next Delay module
Add Storage animation separately, identify with this logical storage by name
Storage data module – entry made there by Store module

– Delay module to listen to initial recording, make selection
Could have used Process module, but this is simpler, faster

– Unstore module to make entity animation disappear

Alternate strategy – 
Queue module from 
Blocks panel ... 
details in text
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Model 5-1:  Simple Call Center
Arrivals, Direct to Service (cont’d.)

• Decide module – Determine Call Type
▪ Three-sided coin flip – Type = N-way by Chance

– Add button for more sides of coin
– Get new exit point for each Add, plus one for Else
– Note that probabilities are entered as percentages (0-100, not 0-1)
– Last entry is “else”

• Direct call to one of tech support, sales, or order-
status areas

Backed each area with colored box
Alternative way to organize – Submodels
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Model 5-1:  Simple Call Center
Tech-Support Calls
• Assign module

▪ Change Entity Type for separating out in results
▪ Change Entity Picture for animation

• Store – Delay – Unstore for recording, product 
type selection

• Decide module for product type
▪ Different three-sided coin flip
▪ Direct to appropriate Process module for that product type

• Process modules for tech-support service
▪ Seize-Delay-Release
▪ Seize a unit from appropriate multi-unit Resource
▪ Use Tech Time defined in Expression data module

• Proceed to system exit logic ... later
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Model 5-1:  Simple Call Center
Sales Calls
• Assign module – change Entity Type, Picture
• Process module

▪ Seize-Delay-Release
▪ Seize a unit of Sales Resource

• Sales calls priority over order-status calls that 
seek a person?
▪ Queue data module, Process Sales Call.Queue

– Type = Lowest Attribute Value
Attribute Name = Sales Call Priority
Undefined for sales calls, so has value 0 ... will set to 1 for order-status calls that 

seek a person, putting sales calls ahead in the queue

– Shared queue (with order-status calls seeking a person)

• Proceed to system-exit logic

Not the only 
way to do this
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Model 5-1:  Simple Call Center
Order-Status Calls
• Assign module – change Entity Type, Picture
• Delay block (Blocks panel) for robo-chat

▪ Includes Store/Unstore logic – alternative to earlier method
– No automatic entry in Storage data module, so must enter manually

• Decide module
▪ No sales person required – go directly to system-exit logic
▪ Sales person required:

– Assign module – set Sales Call Priority Attribute to 1 so 
these will have lower priority than real sales calls

– Seize module for a unit of Sales resource
Define Queue Name = Process Sales Call.Queue – shared with sales calls
Process module does not allow for specifying a shared queue, so can’t use here

– Delay for conversation with sales person
– Release the unit of Sales resource

• Proceed to system-exit logic
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Model 5-1:  Simple Call Center
System Exit
• All calls of all types come here when finished
• Release module – release the unit of Trunk Line 

resource seized upstream
• Assign module – decrement Total WIP variable
• Record module – increment Completed Calls 

counter
• Dispose of call
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Model 5-1:  Simple Call Center
Arrival-Cutoff Logic
• Used to “choke off” arrival stream at 6pm
• Create a single “logical” entity at time 600 min. 

(6pm)
▪ Overkill on making sure just one is created

– Time Between Arrivals = 999999 min., Max Arrivals = 1

• Assign module to set Variable MaxCalls to 1
▪ Recall use of MaxCalls for Max Arrivals in Create module 

for attempted calls
• Dispose of this single logical entity

Creative use of such 
“logical” (a.k.a. “fake”) 
entities enhances modeling 
flexibility, power, detail
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Model 5-1:  Simple Call Center
Run > Setup
• Replication Parameters tab (other tabs as usual)
• Base Time Units = Minutes
• Replication Length = Infinite (the default)
• Terminating Condition field:

TNOW >= 600.0  &&  Total WIP == 0
Arena
clock

Variable

Greater than
or equal to 600
minutes, (6pm)

Logical
“and”

Variable we
maintained

in model

Equality
test for

zero
Base Time Units

It’s 6pm or later               and       there are no calls in the system.

Could have used NR(Trunk Line) 
instead of Total WIP
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Model 5-1:  Simple Call Center
Animation
• Place three Storage animations

▪ Initial Recording Delay, Tech Call Recording Delay, Order 
Status Delay

▪ Select proper Identifier in each from pull-down list
▪ Graphic behaves like Queue animations

• Four Queue animations
▪ Three tech-support call product types, sales
▪ Came with four Process modules specifying Seize

• Resource animations for three tech-support 
types, sales Resources
▪ Multi-unit Resource animations, as in Models 4-3, 4-4
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Model 5-1:  Simple Call Center
Animation (cont’d.)

• Variable animations for WIP at tech calls, sales
▪ For tech calls, Arena variable to animate is
Process Product Type 1 Tech Call.WIP, etc. – 
pull-down list

▪ For sales calls, must include order-status calls seeking a 
real person:
NR(Sales) + NQ(Process Sales Call.Queue)

• Plot number of trunk lines busy,
NR(Trunk Line)

• Labeling, background boxes as in model logic
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Model 5-1:  Simple Call Center
Results (one replication ... sample of size only one!!)

• Trunk-lines-busy plot
▪ Starts, ends at 0 – startup, termination logic
▪ Capped at 26 during run

• 735 attempted calls (User Specified section)
▪ 644 completed, other 91 rejected

• Sometimes see mixture of sales (green), order-
status (blue) entities in sales queue

• Other “usual” outputs
▪ Times in system – separated out by call type
▪ Queue lengths, times in queue – separated out by resource
▪ Resource utilizations – normalized to [0, 1] by capacity
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Model 5-2:  Enhanced Call Center
Changes
• Incoming calls’ arrival rate varies over day

▪ Probabilistic model – Nonstationary Poisson process
– More in Section 12.3

▪ Instead of a constant rate (= 1 / mean interarrival time), 
specify a rate function

– Arena supports piecewise-constant rate function – “step” functions
Easy to specify, strong theoretical support

– Rate-function specification:
In Arena, rates MUST 
be in arrivals per HOUR, 
regardless of base time 
units or time intervalsCaution – it’s 

easy to 
generate this 
incorrectly ... 
see text for 
details
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Model 5-2:  Enhanced Call Center
Changes (cont’d.)

• Sales-staff size varies over day
▪ Data in text, Schedule data module, Sales Schedule

• Tech-support staff are partially cross-trained, 
work complicated schedule:

Will use Arena 
Sets concept to 
implement this 
cross training
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Model 5-2:  Enhanced Call Center
Changes (cont’d.)

• 4% of tech-support calls cannot be handled 
during the call, need offline back-office research
▪ Original call ends, same original talk-time distribution, gives 

up its trunk line, but not counted (yet) as completed
▪ Case sent to back office (outside model boundaries), takes 

EXPO (60) minutes to resolve
– Offline research may be carried over night, completed on a later day

▪ Answer goes back to same tech-support person who took 
original call, with higher priority than incoming calls, but still 
might have to queue for this person

▪ This tech-support person requests a trunk line for outgoing 
call, higher priority than incoming calls, but still might have 
to queue, talks for TRIA (2 ,4 ,9) min., call is now completed

▪ Track number of each product type after research is done
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Model 5-2:  Enhanced Call Center
Data Structure
• Resources, Schedules

▪ Resource, Schedule data modules
▪ Trunk Line – fixed capacity at 26
▪ Sales – on Schedule Sales Schedule
▪ 11 individual tech-support people on individual schedules

– Caution – must fill out each schedule to all 22 half-hour periods, 
with leading/trailing 0’s if necessary ... use Edit via Dialog or 
Spreadsheet, not graphical schedule editor

– Ignore option to avoid shifting back schedule over multiple days
– Include costing data for people in Resource data module

▪ Define nonstationary arrival-rate function in Schedule 
module – Arrival Schedule

– Enter trailing 0’s in Edit via Dialog or Spreadsheet, not graphical 
schedule editor
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Model 5-2:  Enhanced Call Center
Data Structure (cont’d.)

• Sets – collect same-type items together
▪ Set, Advanced Set data modules (Basic, Advanced Process 

panels, resp.)
– Refer to items in set by original name, or index (subscript) in set

▪ Resource set for each tech-support product type
– Members are those tech-support resources qualified
– Individual resources already defined – Resource data module
– Overlapping membership – some resources in multiple sets
– Sets are ordered – here, put most versatile tech-support people at 

bottom, to “save” them for other calls ... Preferred Order in Seize
– Will Seize from a set in model

▪ Counter set – one for each hour
– Count number of rejected calls in each hour
– Individual counters already defined – Statistic data module
– Use results later to decide when to increase staffing
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Model 5-2:  Enhanced Call Center
Modifying the Model
• Call-arrivals, termination, Run > Setup

▪ Create module
– Type = Schedule, Schedule Name = Arrival Schedule

▪ Delete the entire arrival-cutoff section from Model 5-1
– Arrival Schedule cuts off arrivals at 6pm, via 0 rate

▪ Delete Total WIP variable used to terminate Model 5-1
– Use built-in NR(Trunk Line) instead in Terminating Condition
– Delete Assign modules used to manage Total WIP

▪ Record module for rejected calls
– Index into Counter Set Rejected Calls with index

AINT((TNOW/60) + 1)
 which is 1 for first hour, 2 for second hour, etc. (AINT truncates 

decimals toward zero)
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Model 5-2:  Enhanced Call Center
Modifying the Model (cont’d.)

• Tech-support calls
▪ Same through Determine Product Type Decide
▪ Add Assign modules for each product type thereafter

– Entity Type to distinguish product type in reports
– Entity Picture to distinguish product type in animation
– Attribute Tech Call Type (1, 2, or 3 by product type) for routing

▪ Process modules, Resources subdialogs
– Type = Set
– Set Name = Product 1, etc.
– Selection Rule = Preferred Order, to select earlier entries in set first

Recall – we put more versatile tech-support people lower in the set list

– Save Attribute = Tech Agent Index
Entity attribute, carried along, in case of back-office research to send back to this 

same tech-support person for return call
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Model 5-2:  Enhanced Call Center
Modifying the Model (cont’d.)

• Back office, returned tech-support calls – all new
▪ Entry via True branch (4%) in Decide module
Backoffice Research and Return Call?

▪ Release this call’s trunk line – going offline now
▪ Delay (with storage) for EXPO (60) back-office research
▪ Increment Tech Return WIP(Tech Call Type)

– 1-dim. Variable array – defined in Variable data module
– Tech Call Type is 1, 2, or 3, assigned in earlier Assign module

▪ Decide module Product Type? based on Entity Type
▪ Seize the same tech-support person – higher priority
▪ Then seize a trunk line (higher priority), make return call
▪ Then release this trunk line, tech-support person
▪ Decrement Tech Return WIP(Tech Call Type)
▪ Send entity to final Record, after trunk-line release there
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Model 5-2:  Enhanced Call Center
Modifying the Model (cont’d.)

• Statistic data module
▪ Ten Counter-type statistics, discussed earlier
▪ Four Time-Persistent statistics to track expressions

– Backoffice Research WIP to track total number of cases in 
research, via NSTO(Backoffice Research Storage)

– Tech 1 Total Online WIP Stat, etc., to track number of that 
product type in back office via Expression Tech 1 Total Online 
WIP, etc., defined in Expression data module as

Process Product Type 1 Tech Call.WIP + Tech Return WIP(1), etc.

• No changes needed in sales-calls or order-status-
calls section of Model 5-1
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Model 5-2:  Enhanced Call Center
Modifying the Model (cont’d.)

• Animation
▪ Delete Tech 1, Tech 2, and Tech 3 resource animations
▪ Change variables in three tech-support WIP displays to 

track total number of tech-support calls of that type present
▪ New back-office storage animation, variable animation for 

number present
▪ A new queue for each tech-support product type for return 

calls waiting for service
▪ Added a resource animation (from a .plb library) for each 

individual tech-support person
– Grouped by product type, colors for capabilities

• Results
▪ Most rejected calls in hours 5-8 ... increase staff then?
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Model 5-3:  Overall Call-Center Stats
Setup
• Develop an overall operational-cost measure

▪ Two cost categories – staffing/resource, and poor service
• Also develop overall measure of service, % of 

calls rejected
• Also add options for increased staffing, 

improvement
• Make 5 replications, focus on weekly costs

▪ IID replications, so will not carry over back-office research
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Model 5-3:  Overall Call-Center Stats
Staffing/Resource Costs
• Resource data module – hourly costs for people

▪ $20/hr. for each sales staffer
▪ $18/hr. - $20/hr. for each tech-support, depending on skill
▪ These salary costs paid when on duty, busy or idle
▪ Summing, get $12,820/week (details in text)
▪ View all this existing staff as fixed
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Model 5-3:  Overall Call-Center Stats
Staffing/Resource Costs (cont’d.)

• Increase sales, tech-support staff noon-4pm
▪ Variable New Sales = number of new sales staff

– $17/hr., 4 hrs./day, 5 days/week, so $340/week for each add’l. staff
– Schedule data module to add capacity – edit via dialog or 

spreadsheet, not graphical editor
– Resource (Sales) already exists in Resource data module

▪ Variables New Tech 1, etc., and New Tech All for 
number of new tech-support people qualified as named

– $16/hr. for each one-product staff, $18/hr. for each all-product staff
$320/week for each single-product staff, $360/week for each all-product staff

– New entries in Resource data module
Larry, Moe, Curly, Hermann for 1, 2, 3, All, resp.

– Schedule data module to add capacity – dialog or spreadsheet edit
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Model 5-3:  Overall Call-Center Stats
Staffing/Resource Costs (cont’d.)

• Maybe increase number of trunk lines beyond 26
▪ $98/week flat fee for each trunk line

• Define Expression New Res Cost for all resource 
costs:

 New Sales*340
+ (New Tech 1 + New Tech 2 + New Tech 3)*320
+ New Tech All*360
+ 98*MR(Trunk Line)

▪ This does not depend on simulation results, only on setup
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Model 5-3:  Overall Call-Center Stats
Customer-Dissatisfaction Costs
• Incur cost for caller wait on hold, past a threshold

▪ 3 min. for tech, 1 min. for sales, 2 min. for order-status
▪ Beyond threshold, incur per-min. costs of

$0.368 for tech, $0.818 for sales, $0.346 for order-status
– In practice, such costs are difficult to estimate

▪ Three new Assign modules (orange backing) accumulate 
“excess” (beyond threshold) wait times on hold

– Tech support (other two are similar):  Variable
Excess Tech Wait Time increased by
MAX(ENTITY.WAITTIME - 3, 0)

ENTITY.WAITTIME is built-in Arena attribute holding all wait times (including in 
queues) so far ... luckily, there were none before the preceding Process module

▪ At end, multiply excess wait times by per-min. costs, 
multiplied by 5 (to put on a weekly basis)

 5  $0.368 = $1.84 for tech, 5  $0.818 = $4.09 for sales,
5  $0.346 = $1.73 for order-status
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Model 5-3:  Overall Call-Center Stats
Overall Output Performance Measures
• Statistic data module, Total Cost entry

▪ Type = Output, computed only at end of replication
  New Res Cost
 + Excess Sales Wait Time  * 4.09
 + Excess Status Wait Time * 1.73
 + Excess Tech Wait Time   * 1.84
 + 12820

• Statistic data module, Percent Rejected entry
▪ Counter Total Rejected Calls accumulated in new 

Record module in call-arrival area (orange backing)
– Already accumulating hour by hour, but this is total over the day

▪ Type = Output
100 * NC(Total Rejected Calls) / NC(Attempted Calls)

– NC is Arena function that returns the value of that counter
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Model 5-3:  Overall Call-Center Stats
Replication Conditions
• Run > Setup > Replication Parameters,

Initialize Between Replications
▪ Statistics?  System?  Details in text
▪ Default is both – only way to get truly IID replications

– Destroys overnight tech-support research jobs, but to do otherwise 
would complicate model – so accept

• Run > Setup > Project Parameters
▪ Turned off all but Costing Statistics Collection, for speed

– Costing required to get ENTITY.WAITTIME
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Model 5-3:  Overall Call-Center Stats
Results
• Results from five replications

▪ Base Case – no additional staff, still 26 trunk lines
  Total Cost = $22,500.07
  Percent Rejected = 12.9%
▪ Add 3 of each of five staff types, 3 more trunk lines
  Total Cost = $22,668.69
  Percent Rejected = 1.6%

• Use in Chapt. 6 for statistically valid experiments
▪ Statistical precision
▪ Compare several alternatives, select best
▪ Search for configuration that minimizes cost, subject to 

upper limit on percent rejected

Average over 5 replications
Conf. int. half-widths in output

Is this better?
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Model 5-4:  (s, S) Inventory Simulation
Setup
• Different kind of model – not queueing
• Use Blocks and Elements panels exclusively – 

SIMAN simulation language
▪ Mostly just to demonstrate this capability
▪ Could be done with higher-level panels we’ve been using

• Company carries a single discrete item (widgets) 
in inventory

•I(t) = inventory level (an integer) at time t days 
past the beginning of the simulation; I(0) = 60

• Run simulation for 120 round-the-clock days
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Model 5-4:  (s, S) Inventory Simulation
Customer Demands Against Inventory
• Customer interarrival times ~ EXPO (0.1) day 

(round the clock)
▪ First arrival not at time 0 but after an interarrival time past 0

• Demand size is discrete random variable
▪ 1, 2, 3, 4 with respective probabilities

0.167, 0.333, 0.333, 0.167
• If enough items are physically on hand in 

inventory to satisfy a demand, customer gets 
demand and leaves

• If demand > number of items on hand, customer 
gets whatever is there and the rest of the demand 
is backlogged (I(t) becomes negative)
▪ If I(t) was already negative, it just goes more negative
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Model 5-4:  (s, S) Inventory Simulation
Inventory Review, Replenishment
• “Take inventory” just past midnight each day

▪ So at exactly times 0, 1, 2, ..., 119 (not 120 ... see below)
▪ Two managerially-chosen constant integers s = 20 and

S = 40 (must have s < S if we change these values)
▪ If I(t) ≥ s, do nothing until next inventory evaluation exactly 

24 hours later
▪ If I(t) < s, order S – I(t) items from supplier (order “up to” S)
▪ Order does not arrive instantly from supplier, but after a 

delivery lag (a.k.a. lead time) ~ UNIF(0.5, 1.0) day, so 
sometime during the last half of the day of ordering

– In the meantime, inventory level could fall further from additional 
demands, so inventory level will not necessarily pop up to S when 
the order arrives, but to something less than S
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Model 5-4:  (s, S) Inventory Simulation
Cost Structure
• Average ordering cost per day

▪ When an order is placed, incur a fixed cost of $32, plus an 
incremental cost of $3 per item ordered

▪ If no order is placed at the beginning of a day, there’s no 
ordering cost, not even the fixed cost

▪ At end of simulation, divide total of ordering costs by 120
• Average holding cost per day

▪ Whenever I(t) > 0, incur $1 per day per item on hand
▪ Average holding cost = 

• Average shortage cost per day
▪ Whenever I(t) < 0, incur $5 per day per item in backlog
▪ Average shortage cost =
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Model 5-4:  (s, S) Inventory Simulation 
Cost Structure (cont’d.)

• During periods when I(t) = 0 there’s neither 
holding nor shortage cost incurred

• Overall performance measure
 = Average total cost per day
 = sum of average ordering, holding, and 
  shortage costs per day

• Don’t evaluate inventory at time 120
▪ We might order and incur an ordering cost then, but order 

will never arrive
▪ We’ll fudge this, but an Exercise asks you to do it right
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Model 5-4:  (s, S) Inventory Simulation
Data Structure
• Use Blocks, Elements panels exclusively

▪ Even for Variables, Expressions, Attributes, Entities, 
statistics collection, and run control

• Variables Element (initialized, or default to 0 
initially)
▪ Inventory Level = I(t), changes during run, initialized 

to 60
▪ Little s = s = 20
▪ Big S = S = 40
▪ Total Ordering Cost accumulator
▪ Setup Cost = 32
▪ Incremental Cost = 3
▪ Unit Holding Cost = 1
▪ Unit Shortage Cost = 5
▪ Days to Run = 119.9999 (The Fudge)
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Model 5-4:  (s, S) Inventory Simulation
Data Structure (cont’d.)

• Expressions element
▪ Define Interdemand Time, Demand Size, Evaluation 
Interval, Delivery Lag

– Cumulative probabilities in DISC function for Demand Size

• Attributes, Entities elements
▪ Just to define these objects

• Project, Replicate elements
▪ Similar to Run > Setup

• DStats element
▪ Request accumulation of integrals for total holding, 

shortage costs
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Model 5-4:  (s, S) Inventory Simulation
Data Structure (cont’d.)

• Outputs element
▪ Two entries, both of Data type “Output” so that they’re 

executed only at end of run, and reported
▪ Avg Ordering Cost computed
▪ Avg Total Cost added up

– OVALUE returns most recent value
– DAVG returns time-persistent average
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Model 5-4:  (s, S) Inventory Simulation
Logic for Customer Demands
• Create block for arrival

▪ Entity Type is Customer
▪ Uses Interdemand Time Expression
▪ First Creation after an Interdemand Time

• Assign block to decrement Inventory Level by 
a Demand Size
▪ Demand Size was defined as an Expression
▪ Backlogging naturally happens

• Dispose block for customer exit
▪ If backlogged, is accounted for automatically in the (simple) 

definition and tracking of Inventory Level
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Model 5-4:  (s, S) Inventory Simulation
Inventory Evaluation
• Create block for Inventory Evaluator entities

▪ First Creation at time 0 – evaluate inventory at start of run
▪ Interval is Evaluation Interval, defined as Expression

• Branch block – somewhat like Decide module
▪ To determine whether to place an order now
▪ Add “branches,” each evaluated as true or false
▪ Clone of incoming entity sent out along each “true” branch, 

but at most Max Number of Branches will be sent out
– So we set Max Number of Branches to 1 (default is )

▪ First branch of type “If” – if “true” we want to order
▪ Second branch of type “Else” – if “true” it means that the 

first branch was “false” so we don’t order – just Dispose
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Model 5-4:  (s, S) Inventory Simulation
Placing an Order
• If we exit the Branch block via the top “If” branch, 

it must be that I(t) < s so we want to order up to S
• Assign block

▪ Define Order Quantity Attribute
– Could have made this a Variable in this model with these 

parameters, but it’s more general for it to be an Attribute ... why?
▪ Increment Total Ordering Cost Variable

• Delay block for Delivery Lag
• Assign block to increment Inventory Level by 

the Order Quantity
• Dispose block
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Model 5-4:  (s, S) Inventory Simulation
Animation
• Plot separate “in the black” and “in the red” 

curves
▪ If in backlog, red curve will be plotted in negative direction 

due to its Expression
• Pair of Level (“thermometer”) animations

▪ Fill Direction for “in the red” is Down
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What We’ll Do ...

• Model 7-1:  A small manufacturing system
▪ Entity-dependent Sequences
▪ Data requirements and availability
▪ Verification (debugging)

• Statistical analysis of steady-state simulations
▪ Warmup and run length
▪ Truncated replications
▪ Batching
▪ Other methods and goals
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Model 7-1:
A Small Manufacturing System

• Part arrivals, four cells, part departures
• Cells 1, 2, and 4: single machine each
• Cell 3: two machines — newer one 20% faster

▪ Need: way to model non-identical resource units
• Circular layout of cells
• Parts enter at left, exit at right, travel only 

clockwise, all transfer times = 2 min. (realistic?)
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A Small Manufacturing System (cont’d.)

• Three separate part types
▪ Interarrivals (all types merged) ~ expo(13) minutes
▪ 26% type 1, 48% type 2, 26% type 3

• Different part types follow different routes, have 
different (triangular) processing times:

• Observe utilizations, time/number in queues, 
cycle times (times in system) by part type

• Run for 32 hours

Parameters 
are for the 
slow machine 
at Cell 3.
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New Arena Concepts

• Non-identical machines at Cell 3
• Different entity types follow different process 

plans
▪ Previous models – all entities went through same sequence 

of stations, maybe with Decides for branching
▪ Now, need process plan with automatic routing by entity 

type – different Sequence assigned to each entity (like an 
attribute), and entity follows its own sequence

▪ Won’t use direct Connect or Routes … instead we tell 
entities departing from modules to follow their own 
Sequence

▪ Arena internally keeps track of where entity is, where it will 
go next
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The Modeling Approach

• Usually there are many ways to build a (correct) 
Arena model
▪ And also many ways to do so incorrectly …

• Important to think about data structures
▪ What data are available?
▪ How will they be stored in the model?

• For this model …
▪ Use Sequence for part transfer (described below)
▪ As part of Sequence definition, can define Attributes

– Do for processing times at all cells but Cell 1
▪ Use an Expression for processing times at Cell 1
▪ Use Variables for new-machine speedup at Cell 3, part 

transfer times
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Sequence Data Module

• Advanced Transfer panel
• Double-click for new row for each process plan

▪ Name for each Sequence
▪ Open Steps column for subdialog

– Define ordered sequence of Stations to be visited in the Sequence 
… must have Station Names already defined

– Double-click to add a new Station to the bottom of the Sequence 
list; right-click to insert/delete a row

– Name for each step
– Possible Assignments of Attribute, Variable, Pictures, etc. at each 

station in the Sequence … this is done before transferring the entity 
to this step in the sequence

– In this model, Attribute assignment used to attach Process Time 
Attribute to entity for the next Cell (except for Cell 1)
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Sequence Data Module (cont’d.)

• Assign Sequence Name to entities that follow it
• In Route modules, select Sequence as 

Destination Type (rather than Station)
▪ Departing entity looks in its own sequence to know where 

to go next
• Arena tracks Sequence-following entities via 

automatic attributes
▪ Sequence name, NS (or Entity.Sequence)
▪ Station (where entity is or is going to), M (or Entity.Station)
▪ JobStep along the sequence, IS (or Entity.JobStep)

• Normally, entity is assigned a Sequence, travels 
its route, then exits
▪ Can interrupt this sequence, jump forward/backward (tricky)

• Remember to define the “exit” station
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Expression Data Module

• Advanced Process panel
• Use for processing times at Cell 1

▪ Could have done in Sequences, as for other Cells … done 
this way mostly to illustrate its use

• Three different part types at Cell 1, so use a 
vector-valued Expression with three rows
▪ Name for the expression, Cell 1 Times
▪ Rows, 3
▪ Expression Values subdialog

– Cell 1 processing times for the three part types
– Order matters, since index is part type … will reference as
Cell 1 Times(Part Index) in model
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Variable Data Module

• Basic Process panel
• Factor variable

▪ Speed factor at Cell 3 – need a two-row vector
– Assume new (faster) machine is #1, old (slower) machine is #2
– Set to 0.8 for index 1; set to 1.0 for index 2

• Transfer Time variable
▪ Holds transfer-time constant of 2 minutes between stations
▪ Just a scalar, not a vector or matrix 
▪ Used for model generality – if all transfer times changed, 

this makes it easy to implement this change
• These are the Initial Values of variables … any 

entity can change them
▪ But they’re constant in this model
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Set Data Module

• Basic Process panel
• Define three sets

▪ Resource set, Cell 3 Machines
– For new and old machine (in that order) at Cell 3
– Resource Names – could have already defined them in Resource 

data module, or can define them here
▪ Entity Picture set, Part Pictures

– To attach to entities once their part type is determined
– Picture Names – could have already defined them elsewhere

(Edit > Entity Pictures), or can define them here
▪ Entity Type set, Entity Types

– To attach to entities once their part type is determined
– Entity Types – define them here
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Advanced Set Data Module

• On Advanced Process panel
• Needed since Set data module does not have 

“Other” category for Type
▪ Need to form a set of Sequences to attach the right one to 

arriving entities once their part type is determined
▪ Define Name of set to be Part Sequences
▪ Set Type is “Other”
▪ Members subdialog – Add rows, type in names in “Other” 

column (have to remember or look up the Sequence 
names)
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Run > Setup and Edit > Entity Pictures

• Run > Setup Dialog
▪ Replication Parameters Tab

– Replication Length = 32 Hours
– 24 Hours/Day
– Base Time Units = Minutes

• Edit > Entity Pictures
▪ Create three custom pictures – Picture.Part 1, 
Picture.Part 2, Picture.Part 3

▪ Copy blue, red, and green ball pictures
▪ Rename them
▪ Picture Editor to put white numbers inside via Text object
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Part Arrivals

• Create module for arrival of one part
▪ One-at-a-time, Time Between Arrivals is exponential with 

mean 13 minutes
▪ Don’t know the part type yet …

• Assign module for part attributes
▪ Part Index = draw from DISC probability distribution

– Pairs cumulative probability, value
▪ Entity.Sequence = Part Sequences(Part Index)

– Part Index attribute already assigned … order matters
– Index into Part Sequences (Advanced) Set

▪ Entity.Type = Entity Types(Part Index)
▪ Entity.Picture = Part Picture(Part Index)
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Release Arriving Entity into System

• Use previously defined Sequences, assigned to 
entity via (Advanced) Set of Sequences

• Send arriving entity through a Station module to 
define its current station location
▪ Station Name = Order Release
▪ Other five station names already defined via Sequences

• Route module to start it on its way
▪ Route Time = Transfer Time (a Variable previously 

defined) Minutes
▪ Destination Type = Sequential

– Arena will direct this entity according to its own sequence
– It just arrived so Arena initializes its JobStep attribute
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Logic for Cell 1

• Station module to define the station location
▪ Station Name = Cell 1, on pull-down list for stations since 

it was previously defined in Sequences
• Cell 1 Process module

▪ Action = Seize Delay Release
▪ Resources subdialog

– Type = Resource (not Set … yet)
– Resource Name = Cell 1 Machine, Quantity to seize = 1

▪ Delay Type = Expression
– Expression = Cell 1 Times(Part Index) Minutes, using the 

previously-defined Expression Cell 1 Times

• Route module from Cell 1
▪ Destination Type = Sequential
▪ Station already defined (on incoming side)
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Logic for Cells 2 and 4

• Incoming Station module – similar to Cell 1
▪ Except for names of Module and Station

• Process module
▪ Action, Resources, Delay Type – similar to Cell 1
▪ Expression for Delay time = Process Time

– Attribute defined in Sequence module for each job type at this point 
in its sequence for Cells 2 and 4

– Note that Part Type 2 visits Cell 2 twice in its sequence, with 
different delay-time distributions … this data structure is general 
enough to handle this

• Outgoing Route module – similar to Cell 1
▪ Except for name of Module
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Logic for Cell 3

• Station, Route modules – similar to Cells 1, 2, 4
• Process module

▪ Action, Delay Type – similar to Cells 1, 2, 4
▪ Resources subdialog

– Type = Set, Set Name = Cell 3 Machines
– Selection Rule for set = Cyclical

Maybe Preferred Order would have been better???
– Save Attribute = Machine Index (will be 1 or 2)

▪ Expression for Delay time =
  Process Time * Factor(Machine Index)
to multiply by 0.8 if entity gets the new machine (#1), using 
the preciously-defined vector variable Factor

▪ See book for alternative (cute) expression that avoids the 
need for the vector variable Factor



Simulation with Arena, 3rd ed. Chapter 7 – Intermediate Modeling & Steady-State Stat. Analysis Slide 19 of 37

Digression: Data Structures

• Why an Expression for processing times at Cell 1 
rather than entity Attribute assigned in 
Sequences as for the other cells?
▪ Frank answer: Just to show the use of Expression
▪ Could easily have treated Cell 1 like the others

• Conversely, could have used Expression for 
processing times at Cells 3 and 4
▪ But there would be a problem with Cell 2

– Part 2 visits it twice with different processing-time distributions, so 
would have to indicate which visit somehow

▪ Moreover, this is a very small model
• Moral:  Think carefully about data structure!
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Logic for Exiting the System

• Station module to define this location
▪ Station Name = Exit System

• Dispose module
▪ Record Entity Statistics box is checked
▪ Will generate one of the outputs we want, cycle time (time 

in system) separated out by part type, since they map onto 
the entity types for this model

▪ So don’t need separate Record modules here to collect 
cycle times

• Model would run at this point, give correct output 
results … but develop animation to show queues, 
resources, and movement …
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Animation

• Pull animation away from logic, data modules
• Move, resize, reorient queues for realism
• Animate Routes (all movement possibilities)

▪ Thick “bundles” of routes — Shift key, Snap to Grid
▪ Heed clockwise direction
▪ Draw lines to define route “lanes”

• Import, modify AutoCAD .dxf file for backdrop 
and resource pictures (see text)

• Fine-tune resource pictures
▪ Layers for seize point

• In animation, note that entities travel at very 
different rates, pass each other … realistic???
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Verification

• System → Model → “Code”
• Validation:  Is Model = System?
• Verification:  Is “Code” = Model?  (debugging)
• The Truth:  Can probably never completely verify, 

especially for large models
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Verification (cont’d.)

• Some techniques to attempt verification
▪ Eliminate error messages (obviously)
▪ Single entity release, Step through logic

– Set Max Batches = 1 in Arrive
– Replace part-type distribution with a constant

▪ “Stress” model under extreme conditions
▪ Performance estimation — like slide-rule decimal 

placement
▪ Look at generated SIMAN .mod and .exp files

– Run > SIMAN > View
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Statistical Analysis of Output from 
Steady-State Simulations

• Recall:  Difference between terminating, steady-
state simulations
▪ Which is appropriate depends on goal of study, and not so 

much on the model structure
– Most models could be used for terminating or steady-state analysis

• Now, assume steady-state is desired
▪ Be sure this is so, since running and analysis is a lot harder 

than for terminating simulations
• Naturally, simulation run lengths can be long

▪ Opportunity for different internal computation order
▪ Can change numerical results
▪ Underscores need for statistical analysis of output
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Warm Up and Run Length

• Most models start empty and idle
▪ Empty:  No entities are present at time 0
▪ Idle:  All resources are idle at time 0
▪ In a terminating simulation this is OK if realistic
▪ In a steady-state simulation, though, this can bias the 

output for a while after startup
– Bias can go either way
– Usually downward (results are biased low) in queueing-type models 

that eventually get congested
– Depending on model, parameters, and run length, the bias can be 

very severe
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Warm Up and Run Length (cont’d.)

• Remedies for initialization bias
▪ Better starting state, more typical of steady state

– Throw some entities around the model
– Can be inconvenient to do this in the model
– How do you know how many to throw and where?

This is what you’re trying to estimate in the first place!

▪ Make the run so long that bias is overwhelmed
– Might work if initial bias is weak or dissipates quickly

▪ Let model warm up, still starting empty and idle
– Run > Setup > Replication Parameters: Warm-up Period

Time units!

– “Clears” all statistics at that point for summary report, any Outputs-
type saved data from Statistic module of results across replications
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Warm Up and Run Length (cont’d.)

• Warm-up and run length times?
▪ Most practical idea: preliminary runs, plots
▪ Simply “eyeball” them
▪ Be careful about variability — make multiple replications, 

superimpose plots
▪ Also, be careful to note “explosions”

• Possibility – different Warm-up Periods for 
different output processes
▪ To be conservative, take the max
▪ Must specify a single Warm-up Period for the whole model
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Warm Up and Run Length (cont’d.)

• Create a single overall output performance 
measure for Model 7-1 … modify it into Model 7-2
▪ Measure is time-average total number of parts in system
▪ Statistic module

– Time-Persistent type, Name and Report Label Total WIP
– Expression (via Expression Builder … details in book)

EntitiesWIP(Part 1) + EntitiesWIP(Part 2) + EntitiesWIP(Part 3)

– Output File Total WIP History.dat to save within-run data
Animated plots disappear, can’t overlay plots from multiple replications … will use 

Output Analyzer to plot the saved data

▪ Speed up the run
– Check Run > Run Control > Batch Run (No Animation)
– Uncheck boxes in Run > Setup > Project Parameters, Dispose 

module
▪ Lengthen Replications to 5 days, do 10 Replications
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Warm Up and Run Length (cont’d.)

• In Output Analyzer
▪ New data group, Add the file Total WIP History.dat
▪ Graph > Plot or
▪ Add Total WIP History.dat, Replications = All, enter 

Title, axis labels

▪ No apparent explosion
▪ Warm-up about 2000 min.; round up to 2 days (2880 min.)
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Truncated Replications

• If you can identify appropriate warm-up and run-
length times, just make replications as for 
terminating simulations
▪ Only difference:  Specify Warm-up Period in

Run > Setup > Replication Parameters
▪ Proceed with confidence intervals, comparisons, all 

statistical analysis as in terminating case
• Model 7-3: modify Model 7-2

▪ Warm-Up period = 2 Days
▪ Stick with (total) replication length of 5 Days
▪ Stick with 10 replications
▪ Delete Output File in Statistic module
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Truncated Replications (cont’d.)

• Get cross-replications 95% confidence-interval 
Half Widths in Reports
▪ For average Total WIP, got 16.39  6.51
▪ Without the Warm-up, this was 15.35  4.42
▪ To sharpen the comparison of the effect of the Warm-up, 

did 100 (rather than 10) replications with and without it:
– With Warm-up: 15.45  1.18
– Without Warm-up: 14.42  0.86

▪ Half Widths with Warm-up are larger since each replication 
is based on the last 3 days, not all 5 days

• Smaller confidence intervals?  Have a choice:
▪ More replications, same length
▪ Same number of replications, each one longer

– This might be the safer choice to guard against initialization bias
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Batching in a Single Run

• If model warms up very slowly, truncated 
replications can be costly
▪ Have to “pay” warm-up on each replication

• Alternative:  Just one  R  E  A  L  L  Y  long run
▪ Only have to “pay” warm-up once
▪ Problem:  Have only one “replication” and you need more 

than that to form a variance estimate (the basic quantity 
needed for statistical analysis)

– Big no-no:  Use the individual points within the run as “data” for 
variance estimate

– Usually correlated (not indep.), variance estimate biased
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Batching in a Single Run (cont’d.)

• Break each output record from the run into a few 
large batches
▪ Tally (discrete-time) outputs:  Observation-based
▪ Time-Persistent (continuous-time):  Time-based

• Take averages over batches as “basic” statistics 
for estimation:  Batch means
▪ Tally outputs:  Simple arithmetic averages
▪ Time-Persistent:  Continuous-time averages

• Treat batch means as IID
▪ Key: batch size must be big enough for low correlation 

between successive batches (details in text)
▪ Still might want to truncate (once, time-based)
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Batching in a Single Run (cont’d.)

• Modify Model 7-3 into Model 7-4
▪ One replication of 50 days (about the same effort as 10 

replications of 5 days each)
▪ A single 2-day Warm-up Period
▪ Statistic module, save WIP data once again for plot

How to choose batch 
size?

Equivalently, how to 
choose the number of 
batches for a fixed run 
length?

Want batches big enough 
so that batch means 
appear uncorrelated.
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Batching in a Single Run (cont’d.)

• Arena automatically attempts to form 95% 
confidence intervals on steady-state output 
measures via batch means from within each 
single replication
▪ “Half Width” column in reports from one replication

– In Category Overview report if you just have one replication
– In Category by Replication report if you have multiple replications

▪ Ignore if you’re doing a terminating simulation
▪ Uses internal rules for batch sizes (details in text)
▪ Won’t report anything if your run is not long enough

– “(Insufficient)” if you don’t have the minimum amount of data Arena 
requires even to form a c.i.

– “(Correlated)” if you don’t have enough data to form nearly-
uncorrelated batch means, required to be safe
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Batching in a Single Run (cont’d.)

• Results from Model 7-4:
▪ Category Overview report, average total WIP: 13.64  1.38
▪ Half Width considerably smaller than for truncated 

replications (10 replications, 5 days each, 2-day Warm-ups)
– Here we spend only a total of 2 days warming up, and with 

truncated replications we spent 10  2 = 20 days warming up

• Can check batch-means half widths during run
▪ Arena variables THALF(Tally ID), DHALF(Dstat ID)

• Can decide on your own batch sizes, form batch 
means and c.i.’s “by hand” with Output Analyzer
▪ Why?  Use in statistical comparison procedures
▪ More information in book
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What To Do?

• Several approaches, methods for steady-state 
statistical analysis … many more exist

• Opinion:
▪ Avoid steady-state simulation … look at goal of project
▪ If you really do want steady-state

– First try Warm-up, truncated replications
– If model warms up slowly, making truncated replications inefficient, 

consider Arena’s batch-means methods in a single long run with a 
single Warm-up Period at its beginning … can’t use statistical 
methods in PAN or OptQuest, though

• Other methods, goals – references in text



Simulation with Arena, 3rd ed. Chapter 8 – Entity Transfer Slide 1 of 25

Entity
Transfer

Chapter 8

Last revision June 9, 2003



Simulation with Arena, 3rd ed. Chapter 8 – Entity Transfer Slide 2 of 25

What We’ll Do ...

• Types of Entity Transfers
• Model 8-1:  Resource-Constrained Transfers
• Models 8-2, 8-3:  Transporters
• Conveyors

▪ Model 8-4:  Non-accumulating
▪ Model 8-5:  Accumulating
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Types of Entity Transfers So Far

• Connect
▪ Zero-delay
▪ Connection graphic vs. module Labels (no graphic)

• Route
▪ Non-zero-delay — constant, r.v., expression
▪ Stations, animated Routes
▪ Fixed routes vs. entity-dependent Sequences

• Connect and Route both assume:
▪ No limit on number in transit at a time
▪ Entities have their own feet
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New Types of Entity Transfers

• Resource-constrained transfers
▪ Limit total number of entities in transit at a time
▪ Entities still have their own feet
▪ Telecommunications (number of packets),

logistics (number of vehicles)
• Material-handling devices

▪ Transporters – fork lifts, trucks, carts, wheelchairs
– Usually place limits on numbers, capabilities of transporters
– Like a Resource, except moveable

▪ Conveyors
– Belts, hook lines, escalators
– Usually limit space on conveyor, speed
– Non-accumulating vs. accumulating
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Model 8-1: Small Manufacturing System 
with Resource-Constrained Transfers

• Original system (Model 7-1)
▪ Assumed all transfer times = 2 minutes … keep (for now)
▪ Parts have their own feet … keep (for now)
▪ No limit on number of parts in transit at a time … dump

– Now – no more than 2 parts can be in motion at a given time
– If other parts are ready to go, they must wait until there’s room to go

• Model via existing constructs — think creatively
▪ Model “space” on the “road” as a Resource
▪ Limit the number of Units of this Resource
▪ Entity must Seize unit of “space” resource before beginning 

trip, Release it at end of trip



Simulation with Arena, 3rd ed. Chapter 8 – Entity Transfer Slide 6 of 25

Two Ways to Model Resource-
Constrained Transfers

• Both use a new Transfer Resource representing 
space on the transitways
▪ Capacity set to 2 in Resource data module

• Maybe the most obvious way (but won’t do) …
▪ Before each Route module insert a Seize module to Seize 

one unit of Transfer (queue, priority details … see text)
▪ After each Station module (except Order Release) insert 

a Release module to free up one unit of Transfer



Simulation with Arena, 3rd ed. Chapter 8 – Entity Transfer Slide 7 of 25

Two Ways to Model Resource-
Constrained Transfers (cont’d.)

• Different way (will do, to illustrate new modules, 
set up for transporters and conveyors) …
▪ Replace Route modules with Leave modules (Advanced 

Transfer panel)
– Transfer Out: Seize unit of Transfer resource before leaving 

station
Resource, Resource Set, particular member of a Resource Set
Can specify priorities

– Also contains the Route operation
– Get individual queues, with animation, for parts waiting to go

▪ Replace Station modules with Enter modules (Advanced 
Transfer panel)

– Defines the Station
– Option of an unload Delay time (0 for this model)
– Transfer In: Release Transfer resource

• Effect – slight increase in cycle times in system
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Transporter Concepts
• Carts, fork lifts, trucks, wheelchairs, people, …
• When entity is ready to go somewhere, it needs 

to be “picked up” and moved
• Use Transporters — “moveable” resources
• Activities:  Request, Transport, Free

▪ Transporter Selection Rule: If > 1 transporter is available 
when Requesting

▪ When freed and > 1 entity is waiting: Priorities, closest one
• Two types of Transporters

▪ Free-Path (we’ll do)
– Travel time depends only on velocity, distance
– Ignore “traffic jams” and their resulting delays

▪ Guided (won’t do)
– AGVs, intersections, etc.
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The Small Manufacturing System with 
Transporters

• Have two carts to transport parts
▪ A cart can carry one part at a time
▪ Carts move at 50 feet/minute

– Will need to specify accurate distances between Stations

▪ It takes 0.25 minute to load part on a cart, 0.25 minute to 
unload it from a cart

• Modify Model 8-1 to Model 8-2
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The Small Manufacturing System with 
Transporters (cont’d.)

• Create Transporter in Transporter data module 
(Advanced transfer panel)
▪ Name = Cart, Capacity = 2, Velocity = 50
▪ Default the Distance Set (later), Units = Per Minute, Initial 

Positions
– Mind the units – consistency here, in Distance Set (later)

• Animation picture for Cart Transporter
▪ Transporter button     , Animate Transfer toolbar
▪ Identifier = Cart, pictures for Idle, Busy, Inactive states
▪ Draw or copy from .plb picture libraries
▪ Ride point (details in book)
▪ Drop it anywhere in flowchart view (hidden during run)
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The Small Manufacturing System with 
Transporters (cont’d.)

• Request a Cart – modify existing Leave modules
▪ Delay = 0.25 Minute for load time
▪ Transfer Out = Request Transporter
▪ Transporter Name = Cart
▪ Selection Rule = Smallest Distance

– Applies when > 1 transporter is available
– Others:  Cyclic, Random, Preferred Order, Largest Distance (???)

▪ Save Attribute = Cart # (remember which cart … for later)
▪ Connect Type = Transport

– Move Time disappears … determined by Velocity, Distances (later)
▪ Station Type = Sequence

• Instead of Leave: Request-Delay-Transport
▪ More complex, more flexible – book has details, examples
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The Small Manufacturing System with 
Transporters (cont’d.)

• Free the Cart – modify existing Enter modules
▪ Delay = 0.25 Minute for unload time
▪ Transfer In = Free Transporter
▪ Transporter Name = Cart
▪ Unit Number = Cart # attribute of part entity

• Instead of Enter: Station-Delay-Free
▪ More complex, more flexible – book has details, examples
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Distances for Transporters

• Define contents of Distance Set Cart.Distance
• Distances (in feet) moved by parts:

▪ Blank cells: part movements that don’t occur
• Enter these data in Distance data module 

(Advanced Transfer panel)
▪ Name = Cart.Distance
▪ Stations button, add 11 rows with Beginning Station, Ending 

Station, Distance for above data
▪ Direction is implied; could be asymmetric

Units!!

Units!!

Why are there 25 rows??
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Animating Transporter Movement

• Add distances to animation
• Delete all the old Route Path animation objects

▪ But leave the Station animations
• Add animated transporter distances with 

Distance button      , Animate Transfer toolbar
▪ Dialog, placement similar to Route Paths
▪ Identifier = Cart.Distance
▪ Click in Beginning Station marker, intermediate clicks, 

Ending Station marker
▪ Options for Rotate, Flip
▪ Grid, Snap to help place animated transporter distances
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Parking Areas for Transporters

• Animate transporters when they’re free
• Parking button      , Animate Transfer toolbar

▪ Like a Queue animation – Point vs. Line, Shift, Rotate
▪ Cursor becomes cross hairs, click near lower left of Station 

marker to start, click for first Point or head of Line
▪ More clicks for more Points (double-click to end), or second 

click to end Line
▪ Want enough points/space for all transporters (2 here)
▪ Repeat for all Stations where Transporters could be freed
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More Distances — Empty Transporters

• Above Distances incomplete — only for part 
movements along their sequences

• Transporters must also move when empty 
(deadheading)
▪ In general, n(n - 1) distances need definition for network 

with n nodes
▪ Some not possible — Order Release to Exit System

• 14 more distances to define in Distances data 
module (not grayed):
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Model 8-3:  Refining the Animation for 
Transporters

• As it stands, Part Entities disappear from 
animation when waiting to be picked up by a 
Cart Transporter
▪ Model logic OK … get right answers … animation is flawed

• Solution – Storage for entity to reside in, be 
animated, while it waits for something (here, a 
Cart Transporter)
▪ Can get statistics on numbers in Storages

• But Storages not available with modules from 
Advanced Transfer panel
▪ Use lower-level SIMAN modules from Blocks panel … see 

book for specific details
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Conveyors
• Replace Transporters with a conveyor
• Loop conveyor to follow main path, clockwise
• Six entrance/exit points

▪ Load, Unload takes 0.25 minute
▪ Each part is 4 feet per side, but want 6 feet of conveyor 

space for clearance on corners
• Speed = 20 feet/minute
• Distances:

Units!!
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Conveyor Concepts

• Entity to be conveyed must wait for space
• Conveyor consists of cells

▪ Equal size, constantly moving – think of a narrow escalator
• Entities might require multiple contiguous cells
• Must define cell size; tradeoff involved:

▪ Small cells:  accurate model but slow execution
▪ Large cells:  just the opposite!

• Entities Access space, Convey, and Exit
• Conveyor = series of linear Segments

▪ Each segment starts and ends at a Station
▪ Link to form loops, diverge points, converge points
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Types of Conveyors

• Both travel in a single, irreversible direction
• Nonaccumulating: belt, bucket line, escalator

▪ Spacing between entities on it doesn’t change
▪ Entire conveyor stops for entity Access/Exit if Load/Unload 

time is > 0
• Accumulating:  rollers, freeway

▪ Conveyor never stops moving
▪ If entity on it stops to Exit, other entities behind it are 

blocked and bunch up (entities ahead of it keep moving)
▪ When blockage ends, blocked entities go on but maybe not 

all at once (spacing requirements)
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Model 8-4: Small Manufacturing System 
with Nonaccumulating Conveyors

• Modify Model 8-1 (resource-constrained transfer)
• Define new Variables Load Time and Unload 
Time, each with initial value 0.25

• Delete all the Route Paths
• Define Conveyor via Conveyor data module, 

Advanced Transfer panel
▪ Conveyer = Loop Conveyor
▪ Segment Name = Loop Conveyor.Segment
▪ Type = Non-Accumulating
▪ Velocity = 20 (feet), Units = Per Minute
▪ Cell Size = 3 (feet)
▪ Max Cells Occupied = 2 (cells per entity)

Units!!

Units!!
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Leave, Enter Modules for Conveyor

• Change each Leave module
▪ Delay = Load Time, Units = Minutes
▪ Transfer Out = Access Conveyor
▪ Conveyor Name = Loop Conveyor
▪ # of Cells = 2
▪ Connect Type = Convey

• Change each Enter module
▪ Delay = Unload Time, Units = Minutes
▪ Transfer In = Exit Conveyor
▪ Conveyor Name = Loop Conveyor
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Conveyor Segments

• Define one-way lengths (in feet) of segments
• Segment data module, Advanced Transfer panel

▪ Name = Loop Conveyor.Segment
▪ Beginning Station = Order Release
▪ Next Stations button

– Name Next Station in correct sequence
– Give distance (in feet) to this next station

• Segment animation
▪ Put Station markers in front of each Resource picture
▪ Segment button     , Animate Transfer toolbar
▪ Dialog, crosshairs, clicking just like Distances for 

Transporters
– Except here, have to place only 6 Segment animations
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Conveyor Statistics

• Run > Setup > Project Parameters to check 
Conveyor Statistics

• Get percent of time blocked (stopped)
• Utilization statistic is average percent of space 

occupied on conveyor (not percent of time that a 
part was on the conveyor)

• To see conveyor stop (it’s nonaccumulating) 
more clearly, change Load Time and Unload 
Time to much greater values than 0.25
▪ Could do this during run with VBA (Chapter 10), or Run 

Controller – see text for details – but makes output statistics 
nearly impossible to interpret
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Model 8-5: Change Conveyors to 
Accumulating

• Conveyor module
▪ Change Conveyor Type to Accumulating
▪ Accumulation Length = 4 (in feet), amount of space the 

accumulated parts need on the conveyor
• Running, see very little accumulation in 

animation
▪ To see more, increase Load Time and Unload Time
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What We’ll Do ...

• Time frame of simulations
• Strategy for data collection and analysis
• Confidence intervals
• Comparing two alternatives
• Comparing many alternatives via the Arena 

Process Analyzer (PAN)
• Searching for an optimal alternative with 

OptQuest
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Introduction

• Random input leads to random output (RIRO)
• Run a simulation (once) — what does it mean?

▪ Was this run “typical” or not?
▪ Variability from run to run (of the same model)?

• Need statistical analysis of output data
▪ From a single model configuration
▪ Compare two or more different configurations
▪ Search for an optimal configuration

• Statistical analysis of output is often ignored
▪ This is a big mistake – no idea of precision of results
▪ Not hard or time-consuming to do this – it just takes a little 

planning and thought, then some (cheap) computer time
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Time Frame of Simulations

• Terminating: Specific starting, stopping 
conditions
▪ Run length will be well-defined (and finite)

• Steady-state: Long-run (technically forever)
▪ Theoretically, initial conditions don’t matter (but practically 

they usually do)
▪ Not clear how to terminate a simulation run

• This is really a question of intent of the study
• Has major impact on how output analysis is done
• Sometimes it’s not clear which is appropriate
• Here: Terminating (steady-state in Section 7.2)
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Time Frame of Simulations

• Terminating: Specific starting, stopping 
conditions
▪ Run length will be well-defined (and finite)

• Steady-state: Long-run (technically forever)
▪ Theoretically, initial conditions don’t matter (but practically 

they usually do)
▪ Not clear how to terminate a simulation run

• This is really a question of intent of the study
• Has major impact on how output analysis is done
• Sometimes it’s not clear which is appropriate
• Here: Terminating (steady-state in Section 7.2)











Simulation with Arena, 3rd ed. Chapter 6 – Stat. Output Analysis Terminating Simulations Slide 5 of 29

Strategy for Data Collection and 
Analysis

• For terminating case, make IID replications
▪ Run > Setup > Replication Parameters:  Number of 

Replications field
▪ Check both boxes for Initialize Between Replications

• Separate results for each replication – Category 
by Replication report
▪ Model 5-2; Daily Profit, Daily Late Wait Jobs; 10 replications
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Strategy for Data Collection and 
Analysis (cont’d.)

• Category Overview report will have some 
statistical-analysis results of the output across 
the replications

• How many replications?
▪ Trial and error (now)
▪ Approximate number for acceptable precision (below)
▪ Sequential sampling (Chapter 12)

• Turn off animation altogether for max speed
▪ Run > Run Control > Batch Run (No Animation)
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Confidence Intervals for
Terminating Systems

• Using formulas in Chapter 2, viewing the cross-replication 
summary outputs as the basic data:

• Possibly most useful part – 95% confidence interval on 
expected values

• This information (except standard deviation) is in Category 
Overview report
▪ If > 1 replication specified, Arena uses cross-replication data as above
▪ Other confidence levels, graphics – Output Analyzer
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Half Width and Number of Replications

• Prefer smaller confidence intervals — precision
• Notation:

• Confidence interval:

• Half-width =
• Can’t control t or s
• Must increase n — how much?

Want this to be “small,” say
< h where h is prespecified
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Half Width and Number of Replications 
(cont’d.)

• Set half-width = h, solve for
• Not really solved for n (t, s depend on n)
• Approximation:

▪ Replace t by z, corresponding normal critical value
▪ Pretend that current s will hold for larger samples
▪ Get

• Easier but different approximation: 

s = sample standard
deviation from “initial”
number n0 of replications

h0 = half width from 
“initial” number n0 of 
replications

n grows 
quadratically
as h 
decreases
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Half Width and Number of Replications 
(cont’d.)

• Application to automotive repair shop
▪ From initial 10 replications, 95% half-width on Daily Profit 

was ±$50.20 ... let’s get this down to ±$20 or less
▪ First formula: n  1.962(70.172/202) = 47.3, so 48
▪ Second formula: n  10(50.202/202) = 63.0, so 63
▪ Modified Model 5-2 into Model 6-1

– Checked Run > Run Control > Batch Run (No Animation) for speed
– In Run > Setup > Replication Parameters, changed Number of 

Replications to 100 (conservative based on above)

▪ Got 492.63 ± 13.81, satisfying criterion
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Interpretation of Confidence Intervals

• Interval with random (data-dependent) endpoints 
that’s supposed to have stated probability of 
containing, or covering, the expected valued
▪ “Target” expected value is a fixed, but unknown, number
▪ Expected value = average of infinite number of replications

• Not an interval that contains, say, 95% of the data
▪ That’s a prediction interval … useful too, but different

• Usual formulas assume normally-distributed data
▪ Never true in simulation
▪ Might be approximately true if output is an average, rather 

than an extreme
▪ Central limit theorem
▪ Robustness, coverage, precision – see book (Model 6-2)
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Comparing Two Alternatives

• Usually compare alternative system scenarios, 
configurations, layouts, sensitivity analysis
▪ For now, just two alternatives ... more later

• Model 6-3
▪ Model 6-1, but add file Daily Profit.dat to Statistic 

module, Output column, Daily Profit row
▪ Saves this output statistic to this file for each replication
▪ Two versions

– Base case – all inputs as originally defined
– More-bookings case – Change Max Load from 24 to 28 hours 

(allow more bookings per day ... increase utilization, profit?  Maybe)
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Comparing Two Alternatives (cont’d.)

• Reasonable but not-quite-right idea
▪ Make confidence intervals on expected outputs from each 

alternative, see if they overlap
▪ Base case:

  492.63 ± 13.81, or [478.82, 506.44]
▪ More-bookings case:

  564.53 ± 22.59, or [541.94, 567.12]
▪ But this doesn’t allow for a precise, efficient statistical 

conclusion

No
Overlap
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Compare Means via the Output Analyzer

• Output Analyzer is a separate application that 
operates on .dat files produced by Arena
▪ Launch separately from Windows, not from Arena

• To save output values (Expressions) of entries in 
Statistic data module (Type = Output) – enter 
filename.dat in Output File column
▪ Just did for Daily Profit, not Daily Late Wait Jobs
▪ Will overwrite this file name next time … either change the 

name here or out in Windows before the next run
▪ .dat files are binary … can only be read by Output Analyzer
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Compare Means via the Output Analyzer 
(cont’d.)

• Start Output Analyzer, open a new data group
▪ Basically, a list of .dat files of current interest
▪ Can save data group for later use – .dgr file extension
▪ Add button to select (Open) .dat files for the data group

• Analyze > Compare Means menu option
▪ Add data files … “A” and “B” for the two alternatives
▪ Select “Lumped” for Replications field
▪ Title, confidence level, accept Paired-t Test, Scale Display
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Compare Means via the Output Analyzer 
(cont’d.)

• Results:

• Confidence interval on difference misses 0, so 
conclude that there is a (statistically) significant 
difference
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Evaluating Many Alternatives with the 
Process Analyzer (PAN)

• With (many) more than two alternatives to 
compare, two problems are
▪ Simple mechanics of making many parameter changes, 

making many runs, keeping track of many output files
▪ Statistical methods for drawing reliable and useful 

conclusions
• Process Analyzer (PAN) addresses these
• PAN operates on program (.p) files – produced 

when .doe file is run (or just checked)
• Start PAN from Arena (Tools > Process Analyzer) 

or via Windows
• PAN runs on its own, separate from Arena
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PAN Scenarios

• A scenario in PAN is a combination of:
▪ A program (.p) file
▪ Set of input controls that you choose

– Chosen from Variables and Resource capacities – think ahead
– You fill in specific numerical values

▪ Set of output responses that you choose
– Chosen from automatic Arena outputs or your own Variables
– Values initially empty … to be filled in after run(s)

▪ To create a new scenario in PAN, double-click where 
indicated, get Scenario Properties dialog

– Specify Name, Tool Tip Text, .p file, controls, responses
– Values of controls initially as in the model, but you can change them 

in PAN – this is the real utility of PAN
– Duplicate (right-click, Duplicate) scenarios, then edit for a new one

▪ Think of a scenario as a row
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PAN Projects and Runs

• A project in PAN is a collection of scenarios
▪ Program files can be the same .p file, or .p files from 

different model .doe files
▪ Controls, responses can be the same or differ across 

scenarios in a project – usually will be mostly the same
▪ Think of a project as a collection of scenario rows – a table
▪ Can save as a PAN (.pan extension) file

• Select scenarios in project to run (maybe all)
• PAN runs selected models with specified controls
• PAN fills in output-response values in table

▪ Equivalent to setting up, running them all “by hand” but 
much easier, faster, less error-prone
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Model 6-4 for PAN Experiments

• Same as Model 6-3 except remove Output File 
entry in Statistic module
▪ PAN will keep track of outputs itself, so this is faster

• Controls – set up a formal 23 factorial experiment

• Responses
▪ Daily Profit
▪ Daily Late Wait Jobs

Control (factor) “−” Level “+” Level
Max Load 20 40
Max Wait 1 7
Wait Allowance 0.5 2.0

23 = 8 Scenarios
Also do Base Case

Not required to do a designed 
experiment with PAN, but this 
is more informative than 
haphazard fooling around
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Running Model 6-4 with PAN

• Scenarios
▪ Select all to run (click on left of row, Ctrl-Click or Shift-Click for more)
▪ To execute,     or Run > Go or F5

What to make of all this?
Statistical meaningfulness?
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Statistical Comparisons with PAN

• Model 6-4 alternatives were made with 100 
replications each
▪ Better than one replication, but what about statistical 

validity of comparisons, selection of “the best”?
• Select Total Cost column, Insert > Chart (or      or 

right-click on column, then Insert Chart)
▪ Chart Type:  Box and Whisker
▪ Next, Total Cost; Next defaults
▪ Next, Identify Best Scenarios

– Bigger is Better, Error Tolerance = 0 (not the default)
– Show Best Scenarios; Finish
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Statistical Comparisons with PAN (cont’d.)

• Vertical boxes: 
95% confidence 
intervals

• Red scenarios 
statistically 
significantly 
better than blues
▪ More precisely, red 

scenarios are 95% 
sure to contain the 
best one

▪ Narrow down red 
set – more 
replications, or 
Error Tolerance > 0

▪ More details in book
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A Follow-Up PAN Experiment

• From 23 factorial experiment, it’s clear that Max 
Load matters the most, and bigger appears better
▪ It’s factor 1, varying between “−” and “+” in each scenario 

as ordered there, creating clear down/up/down/up pattern
▪ Could also see this by computing main effects estimates

– Consult an experimental-design text

• Eliminate other two factors (fix them at their 
base-case levels) and study Max Load alone
▪ Let it be 20, 22, 24, ..., 40
▪ Set up a second PAN experiment to do this, created chart 

as before
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A Follow-Up PAN Experiment (cont’d.)

• Here, profit-maximizing Max 
Load is about 30

• But Daily Late Wait 
Jobs keeps increasing 
(worsening) as Max Load 
increases
▪ At profit-maximizing Max Load = 

30, it’s 0.908 job/day, which 
seems bad since we only take 5 
wait jobs/day

▪ Would like to require that it be at 
most 0.75 job/day ... still want to 
maximize Daily Profit

▪ Allow other two factors back into 
the picture ...
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• The scenarios we’ve considered with PAN are just 
a few of many possibilities

• Seek input controls maximizing Daily Profit 
while keeping Daily Late Wait Jobs ≤ 0.75

• Formulate as an optimization problem:
Maximize Daily Profit
Subject to 20  Max Load  40
  1  Max Wait  7
  0.5  Wait Allowance  2.0

  Daily Late Wait Jobs < 0.75

▪ Reasonable starting place – best acceptable scenario so 
far: (the base case, actually)

▪ Where to go from here?  Explore all of feasible three-
dimensional space exhaustively?  No.

Searching for an Optimal Alternative 
with OptQuest

An output requirement, 
not an input constraint

Objective function is the simulation model

Constraints on the 
input control 
(decision) variables

Could also have 
constraints on linear 
combinations of input 
control variables (but we 
don’t in this problem)
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OptQuest

• OptQuest searches intelligently for an optimum
▪ Like PAN, OptQuest

– Runs as a separate application … can be launched from Arena
– “Takes over” the running of your model
– Asks that you identify the input controls and the output (just one) 

response objective

▪ Unlike PAN, OptQuest
– Allows you to specify constraints on the input controls
– Allows you to specify requirements on outputs
– Decides itself what input-control-value combinations to try
– Uses internal heuristic algorithms to decide how to change the input 

controls to move toward an optimum configuration

• You specify stopping criterion for the search 
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Using OptQuest
• Tools > OptQuest for Arena
• New session (File > New or Ctrl+N or    )

▪ Make sure the desired model window is active
• Select controls – Variables, Resource levels

▪ Max Load, Lower Bound = 20, Upper Bound = 40, Conts.
▪ Max Wait, Lower Bound = 1, Upper Bound = 7, Discrete 

(Input Step Size 1)
▪ Wait Allowance, Lower Bound = 0.5, Upper Bound = 2, 

Conts.
• Constraints – none here other than earlier Bounds
• Objective and Requirement

▪ Daily Profit Response – Select Maximize Objective
▪ Daily Late Wait Jobs Response – Select 

Requirement, enter 0.75 for Upper Bound
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Using OptQuest (cont’d.)

• Options window – computational limits, 
procedures
▪ Time tab – run for 20 minutes
▪ Precision tab – vary number of replications from 10 to 100
▪ Preferences tab – various settings (accept defaults)

• Can revisit Controls, Constraints, Objective and 
Requirements, or Options windows via

• Run via wizard (first time through a new project), 
or Run > Start or

• View > Status and Solutions and
View > Performance Graph to watch progress

• Can’t absolutely guarantee a true optimum
▪ Usually finds far better configuration than possible by hand
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What We’ll Do ...

• Reading and Writing Data Files (ReadWrite)

• ActiveX  and Visual Basic® for Applications 

(VBA)

• Creating Modules with Arena Professional 

Edition
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Reading and Writing Data Files

• Reading entity arrivals from a text file

• Reading and writing Microsoft Access 

and Excel files

• Advanced reading and writing
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Reading Entity Arrivals From
 a Text File

• Why data-driven simulations?

▪ Model validation

▪ Evaluating how a particular scenario is handled

▪ Modeling a specific arrival pattern

▪ Assumes historical data exist and can be transformed for 

use in simulation
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Simple Call Center Model

• Single call stream 
• Single agent resource
• Random call processing time
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External Call Center Data

• Historical call arrival times
• Model 10-02 Input.txt

▪ ASCII file (e.g., Notepad, saved as text from Excel)
▪ Absolute simulation arrival times

1.038457 
2.374120 
4.749443 
9.899661 
10.525897 
17.098860 
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Model Logic to Read Data

• Can’t use simple time between arrivals 
• Control entity

▪ Create only one
▪ Duplicate to send actual “call” entity into model

Control Entity

Actual “Call” Entity
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Model Logic to Read Data (cont’d.)

• ReadWrite module (Advanced Process)
▪ Arena File Name: description (actual disk filename is 

specified in File module)
▪ Assignments: model variables/attributes to be assigned 

based on data read from file (Call Start Time attribute)
• Delay/Duplicate Logic

▪ File contains “absolute” times; Delay module holds entity 
for a time interval

▪ Delay control entity for interval until actual arrival time of 
call (Call Start Time - TNOW)

▪ Create a duplicate (Separate module) to dispatch actual 
call into model. Original entity loops back to read next time.
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Model Logic to Read Data (cont’d.)

• File data module (Advanced Process)
▪ Name: Name referenced in other Arena modules.
▪ Access Type: Sequential indicates to read in order.
▪ Operating System File Name: The name used by file 

system. May be relative or fully qualified.
▪ End of File Action: What to do when all records are read.
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Run Termination

• Run Setup options
▪ Maximum replications / simulation end time always 

terminates the simulation run.

• System empties
▪ If no entities on calendar and no other time-based controls, 

run may terminate earlier than setup options dictate.
▪ The control entity is disposed after it reads the last data 

value.
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Reading Access Files

• Sample Access 
data
▪ Model 10-03 

Input.mdb
▪ Table: ArrivalTimes
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Reading Access Files

• File data module (Advanced Process)
▪ Access Type: Microsoft Access (*.mdb)
▪ Operating System File Name: Model 10-03 Input.mdb
▪ Recordsets: Click to load the Recordsets Editor

• Important: 
▪ Never name an access file the same as the model name 

or it will conflict with the automatic output database file.
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Reading Access Files

• Recordsets Editor
▪ Associates a recordset name with a table
▪ Table must already exist
▪ View allows you to see a sample of the real data
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Reading Access Files

• ReadWrite module (Advanced Process)
▪ Recordset ID: Same as defined in Recordsets Editor
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Reading Excel Files

• Excel is not a relational database but has many 
similarities:
▪ An Excel workbook is similar to an Access database file.
▪ The rows and columns in a rectangular named range in 

an Excel worksheet are similar to the rows and columns 
of an Access table. 
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Reading Excel Files

• Sample Excel data
▪ Model 10-03 Input.xls
▪ Named Range: ArrivalTimes
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Reading Excel Files

• File data module (Advanced Process)
▪ Access Type: Microsoft Excel (*.xls)
▪ Operating System File Name: Model 10-03 Input.xls
▪ Recordsets: Click to load the Recordsets Editor
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Reading Excel Files

• Recordsets Editor
▪ Associates a recordset name with a named range
▪ Named range must already exist
▪ View allows you to see a sample of the real data
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Writing Access and Excel Files

• The file:
▪ The table or named range must already exist.
▪ An Excel named range should be formatted as numeric.

• ReadWrite module: 
▪ Add new module to specify which data to write.
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Writing Access and Excel Files

• ReadWrite module: 
▪ Use Type of Write To File
▪ Use Recordset ID as before.
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Writing Access and Excel Files

• Spreadsheet options: 
▪ You may predefine a plot on the named range and the 

plot will be built dynamically as data is added to the file.
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Advanced Reading and Writing

• Formatting can be used to handle text files with 
fields not delimited by spaces: 

Part 1  1.038 
Part 27 2.374 
Part 5194.749 
Part 67 9.899 
Part 72 10.52 
Part 16217.09 
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Advanced Reading and Writing

• Skip columns in Access & Excel by using 
dummy variables:
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Advanced Reading and Writing

• Advanced data access is available using 
Access Type of Active Data Objects (ADO) and 
a Connection String:
▪ Excel With Headings Using ADO

▪ SQL Commands Using ADO

Provider=Microsoft.JET.OLEDB.4.0;
Data Source=C:\Documents\Book1.xls;
Extended Properties=””Excel 8.0; HDR=Yes;””

Driver={SQL Server};
Server=RSI-Joe; Database=BizBikes;
Uid=BizWareUser; pwd=MyPassword

Use two double 
quotes for each 

embedded 
double quote
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What We’ll Do ...

• Reading and Writing Data Files (ReadWrite)

• ActiveX  and Visual Basic® for Applications 

(VBA)

• Creating Modules with Arena Professional 

Edition
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ActiveX Automation

• Program applications to “automate” tasks
▪ Act on themselves (e.g., macros in Excel)
▪ Act on other applications (e.g., Arena creating Excel file)

• External programming languages
▪ C++, Visual Basic®, Java, etc.

• Visual Basic for Applications (VBA) programming 
embedded in application
▪ Microsoft Office®, Visio®, AutoCAD®, Arena®, …

• Both types work together (e.g., Arena VBA 
controlling Excel)
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Application Object Model

• Objects: application components that can be 
controlled

• Properties: characteristics of objects
• Methods: actions performed on or by objects

Arena Objects Properties  Methods
Application Visible   Show
Model  Name, State  Close, Go
View  Background Color Zoom In
… 
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Visual Basic for Applications (VBA)

• Included with Arena
• Full Visual Basic programming environment
• Code stored with Arena model (.doe) file
• UserForms (dialogs) for custom interfaces
• Code-debugging tools
• Comprehensive online help
• Visual Basic Editor window: “child” of Arena 

(Tools/Show Visual Basic Editor) 
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Built-in Arena VBA Events

• ThisDocument: accesses objects, events in 
Arena’s object model

• Built-in VBA events: locations where VBA code 
can be activated
▪ Pre-run events (e.g., DocumentOpen)
▪ Arena-initiated run events (e.g., RunBegin, 

RunEndReplication)
▪ Model/user-initiated run events (e.g., UserFunction, 

VBA_Block_Fire)
• Type code in Visual Basic Editor to populate an 

event
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Built-in Arena VBA Events

• ThisDocument: accesses objects, events in 
Arena’s object model

• Built-in VBA events: locations where VBA code 
can be activated
▪ Pre-run events (e.g., DocumentOpen)
▪ Arena-initiated run events (e.g., RunBegin, 

RunEndReplication)
▪ Model/user-initiated run events (e.g., UserFunction, 

VBA_Block_Fire)
• Type code in Visual Basic Editor to populate an 

event
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Simulation Run VBA Events

• Arena/VBA sequence of events when model runs:
1. RunBegin

3. RunBeginSimulation

4. RunBeginReplication

9. RunEnd

7. RunEndSimulation

6. RunEndReplication

5. Arena runs replication 

2. Arena checks and initializes the model

8. Arena terminates the simulation run

Simulation run data
availableOnKeystroke, UserFunction, 

etc.

Module data available

Module data available
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Arena’s Object Model

• Model-window objects: items placed in model 
window, such as:
▪ Modules
▪ Connections
▪ Lines

• SIMAN object: simulation run data, such as:
▪ Variable values
▪ Queue lengths
▪ Simulation time

• Structural objects: access general functions
▪ Application
▪ Panels
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Sample: Create Ten Status Variables

WIP(1) WIP(10)

Dim oModel As Arena.Model

    Dim i As Integer

    Dim nX As Long

    ' Add the status variables to this Arena model

    Set oModel = ThisDocument.Model

    nX = 0                   ' Start at x position 0

    For i = 1 To 10

        ' Add a status variable to the model window

        oModel.StatusVariables.Create nX, 0, _

           nX + 400, 150, "WIP(" & i & ")", "**.*", False, _

           RGB(0, 0, 255), RGB(0, 255, 255), RGB(0, 0, 0), "Arial"

        ' Move over 500 world units for next position

        nX = nX + 500

    Next i









Simulation with Arena, 3rd ed. Chapter 10 – Arena Integration and Customization Slide 33 of 54

Sample: Assign Variable Value 
During Run

Dim oSIMAN As Arena.SIMAN

    Dim nVarIndex As Long

    Dim sNewValue As String

    

    ' Prompt for a new value

    sNewValue = InputBox("Enter the new average cycle time:")

    

    ' Assign their answer to the Mean Cycle Time variable

    Set oSIMAN = ThisDocument.Model.SIMAN

    nVarIndex = oSIMAN.SymbolNumber("Mean Cycle Time")

    oSIMAN.VariableArrayValue(nVarIndex) = sNewValue
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Arena Macro Recorder

• A Macro is a VBA function to perform a task.
• Macro recording automatically creates the VBA 

code to reproduce the actions you take while 
performing the steps in the task.

• Use the Record Macro toolbar to start/stop and 
pause/resume recording.

• Useful for automating repetitive tasks.
• Ideal for learning VBA commands and 

prototyping  functions.
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Model 10-05: Presenting Arrival 
Choices to the User

• Prompt at beginning of run
▪ Generate entities via random process … or …
▪ Generate based on arrival times stored in a file
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Our Approach

• Both sets of logic placed in model window and 
connected to start of call logic (Process module)
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Our Approach (cont’d.)

• Change Max Arrivals field in Create module to 
turn “on” or “off” its generation of entities

• Random interarrival-time process
▪ Create Call module: Infinite
▪ Create Control Entity to Read Data module: 0

• Arrival times from a file
▪ Create Call module: 0
▪ Create Control Entity to Read Data module: 1

• Give unique “tag” to each Create module (so VBA 
code can find them)
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VBA UserForm

• Insert/UserForm menu in Visual Basic Editor
• Drop controls from Control Toolbox (labels, 

option buttons, command button)

Label

Option buttons

Command button
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Show the UserForm

• At beginning of run (ModelLogic_RunBegin), 
show the form:

Option Explicit

Private Sub ModelLogic_RunBegin()

    ' Display the UserForm to ask for the type of arrivals

    frmArrivalTypeSelection.Show

    

    Exit Sub

End Sub

• Program control passes to the form until it’s 
closed

• Arena run “suspended” while form is in control
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Change Module Data On OK

• When user clicks OK button on form, modify the 
Create module data
▪ Find the Create modules
▪ Set the Max Arrivals fields
▪ Play a sound 
▪ Close the UserForm

• When form is closed, simulation run commences 
with the new data values in the Create modules
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Model 10-06: Record Call Data 
in Microsoft Excel

• Our goal:
▪ Raw call data tables
▪ Daily call duration charts
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Using ActiveX Automation in VBA

• Reference the Excel Object Library
▪ Tools/References menu in Visual Basic Editor
▪ Check the Microsoft Excel Object Library
▪ Establishes link between Arena VBA and Excel

• Object variables from application’s object model
▪ Excel.Application, Excel.Workbook
▪ Arena.SIMAN

• Starting Excel
▪ CreateObject: starts application, returning “handle” to the 

program (stored in oExcelApp variable)
▪ oExcelApp.Workbooks.Add: similar to “File/New” in Excel
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Retrieving Simulation Data

• ThisDocument
▪ Built-in variable accessing the Arena model
▪ Use only within Arena’s VBA

• ThisDocument.Model.SIMAN
▪ Used to access simulation run data
▪ Browse (F2) in VBA window for full list of variables
▪ Active only when simulation run data is available -- i.e., 

built-in events:
– after (and including) ModelLogic_RunBeginSimulation
– before (and including) ModelLogic_RunEndSimulation
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Our Approach

• VBA ModelLogic_RunBeginSimulation
▪ Called once at the beginning of the simulation run

– Start Excel with a new spreadsheet (“Workbook”)
– Format header rows for data worksheet

• VBA ModelLogic_RunBeginReplication
▪ Called at the beginning of each replication

– Write headers for the three columns and the Day
– Format the data columns
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Our Approach (cont’d.)

• VBA Module (Blocks panel)
▪ Insert in model logic just before disposing calls

• VBA Code
▪ VBA modules numbered as they’re placed, with 

corresponding VBA_Block_<n>_Fire events in VBA
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Our Approach (cont’d.)

• VBA_Block_1_Fire
▪ Called each time an entity enters the VBA Block in the 

model
▪ Retrieve data from running simulation via SIMAN object 

(stored in oSIMAN variable)
▪ Row and columns into which to write data stored in global 

VBA variables (nNextRow, nColumnA, nColumnB, 
nColumnC)
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Our Approach (cont’d.)

• ModelLogic_RunEndReplication
▪ Called at end of each replication
▪ Creates the chart and updates the global variables
▪ Hint: Use Excel macro recording for “skeleton” code (e.g., 

for formatting commands, creation of chart); copy into 
Arena VBA and adjust variable names (e.g., add oExcelApp 
to access Excel)

• ModelLogic_RunEndSimulation
▪ Turn DisplayAlerts off (overwrites .xls file if it exists)
▪ SaveAs method to give filename
▪ Excel still running. Could use oExcelApp.Quit
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What We’ll Do ...

• Reading and Writing Data Files (ReadWrite)

• ActiveX  and Visual Basic® for Applications 

(VBA)

• Creating Modules with Arena Professional 

Edition



Simulation with Arena, 3rd ed. Chapter 10 – Arena Integration and Customization Slide 49 of 54

Creating Modules with Arena 
Professional Edition

• Template 10-01:
Create from File module
▪ Template (.tpo) can be attached and used in Academic 

Arena
▪ Place and edit 

like any other 
module

▪ Need Research/
Professional Arena 
to create/edit 
template source 
(.tpl)
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Panel Icon and User View

• Panel Icon: “Button” displayed in 
template panel to represent the module

• User View: Graphics objects placed in the model 
window with an “instance” of the module
▪ Module handle
▪ Entry, exit points
▪ Animation
▪ Operand values
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Operands

• Operands: Fields that can be filled out by the 
modeler
▪ Allow different data for each instance of the same module 

type in a model
▪ Passed down to logic via back quotes ( ` )
▪ Entry and exit point operands permit entities to move 

through underlying module logic

Operands
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Module Logic

• Module Logic: A “submodel” containing module 
instances
▪ Can paste from a model into a module definition’s logic 

window
▪ Same interface as for building models

Reference to module 
operand ( `Data File` )

Reference to module 
operand ( `Name` )
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Uses of Templates

• Commercial templates
▪ Arena templates (Basic Process, Advanced Process, etc.)
▪ Contact Center, Packaging templates
▪ …

• Application-focused templates
▪ Terminology, modeling capabilities designed for a particular 

application environment (e.g., mining, material handling, 
order processing)

▪ “Personal” / utility templates
▪ Reuse what you learn
▪ Share your modeling techniques
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Summary

• We have just barely scratched the surface of 
Arena customization and interactions with other 
software including:
▪ Reading and writing various types of external data files. 
▪ Visual Basic for Applications
▪ Interacting with Microsoft Office
▪ Building custom applications with templates.

• There are many other ways of customizing Arena 
and allowing Arena to interact and exchange data 
with other software.
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Purpose & Overview

◼ Discuss the generation of random numbers.

◼ Introduce the subsequent testing for 
randomness:
 Frequency test
 Autocorrelation test.
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Properties of Random Numbers

◼ Two important statistical properties:
 Uniformity
 Independence.

◼ Random Number, Ri, must be independently drawn from a 
uniform distribution with pdf:

Figure: pdf for 
random numbers
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Generation of Pseudo-Random Numbers

◼ “Pseudo”, because generating numbers using a known 
method removes the potential for true randomness.

◼ Goal: To produce a sequence of numbers in [0,1] that 
simulates, or imitates, the ideal properties of random numbers 
(RN).

◼ Important considerations in RN routines:
 Fast
 Portable to different computers
 Have sufficiently long cycle
 Replicable
 Closely approximate the ideal statistical properties of uniformity 

and independence.
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Techniques for Generating Random 
Numbers
◼ Linear Congruential Method (LCM).
◼ Combined Linear Congruential Generators (CLCG).
◼ Random-Number Streams.
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Linear Congruential Method  [Techniques]

◼ To produce a sequence of integers, X1, X2, … between 0 
and m-1 by following a recursive relationship:

◼ The selection of the values for a, c, m, and X0 drastically 
affects the statistical properties and the cycle length.

◼ The random integers are being generated [0,m-1], and to 
convert the integers to random numbers:

,...2,1,0    , mod )(1 =+=+ imcaXX ii
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Example      [LCM]

◼ Use X0 = 27, a = 17, c = 43, and m = 100.
◼ The Xi and Ri values are:

  X1 = (17*27+43) mod 100 = 502 mod 100 = 2, R1 = 0.02;
  X2 = (17*2+43) mod 100 = 77,   R2 = 0.77;
  X3 = (17*77+43) mod 100 = 52,   R3 = 0.52;
  …



Random-Variate Generation



Need for Random-Variates

We, usually, model uncertainty and unpredictability with 
statistical distributions
Thereby, in order to run the simulation models involving 
uncertainty, we need to get samples from these statistical 
distributions
Here, we assume that the distributions (type and 
parameters) are already specified
ARENA comes with ready functions to sample from 
specified distributions.
It is still useful to know how it is done
We will generate the variates always using random 
numbers, whose generation is discussed previously



Inverse Transform Technique --
Exponential Distribution

To generate samples from exponential distribution we use the inverse 
transform technique

Step 1. Compute the cdf of the desired random variable X, F(x).
Step 2. Find the inverse of F(x) function

Step 4. Generate uniform random variables R1, R2, R3, … and compute 
the desired random variates by 
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Inverse Transform Technique --
Exponential Distribution



Inverse Transform Technique --
Exponential Distribution

Example: Generate 200 variates Xi with distribution 
exp(= 1)

◼ Check: Does the random variable X1 have the desired 
distribution?



Proof?

Can you prove that the numbers you have 
generated are indeed samples from an 
exponential distribution? 



Other Distributions

Uniform Distribution [ UN(a,b)]  (X = a + (b-a)R)
◼ Does it really work?

Weibull Distribution

◼ Derive the transformation
Triangular ….
The moral is if we can find a closed-form inverse of the 
cdf for a distribution we can use this method to get 
samples from that distribution
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Continuous Functions without a 
Closed-Form Inverse

Some distributions do not have a closed form expression 
for their cdf or its inverse (normal, gamma, beta, …)
What can be done then?
Approximate the inverse cdf
For the standard normal distribution:

This approximation gives at least one-decimal place 
accuracy in the range [0.0012499, 0.9986501]
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Discrete Distributions

An Empirical Discrete Distribution
◼ p(0) = P(X=0) = 0.50
◼ p(1) = P(X=1) = 0.30
◼ p(2) = P(X=2) = 0.20

Can we apply the inverse transform technique?
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Discrete Distributions

Let x0 = -, and x1, x2, …, xn, be the ordered probability 
mass points for the random variable X
Let R be a random number 
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Discrete Distributions

A Discrete Uniform Distribution
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Discrete Distributions

The Geometric Distribution

Some algebraic manipulation and …

( )
( ) ...,2,1,0,11)(

...,2,1,0,1)(
1 =−−=

=−=
+ xpxF

xppxp
x

x

( )
( ) 








−

−
−

= 1
1ln
1ln

p
RroundupX



Acceptance-Rejection Technique
Useful particularly when inverse cdf does not exist in 
closed form, a.k.a. thinning
Illustration: To generate random variates, X ~ U(1/4, 1)

R does not have the desired distribution, but R
conditioned (R’) on the event {R  ¼} does.
Efficiency: Depends heavily on the ability to minimize 
the number of rejections.

Procedures:
Step 1.   Generate R ~ U[0,1]
Step 2a. If R >= ¼, accept X=R.
Step 2b. If R < ¼, reject R, return    

  to Step 1

Generate R

Condition

Output R’

yes

no



Acceptance-Rejection Technique

Poisson Distribution

◼ N can be interpreted as number of arrivals from a 
Poisson arrival process during one unit of time

◼ Then time between the arrivals in the process are 
exponentially distributed with rate 
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Acceptance-Rejection Technique

Step 1.   Set n = 0, and P = 1
Step 2.   Generate a random number Rn+1 and let P = P. Rn+1 
Step 3.   If P < e-, then accept N = n.  Otherwise, reject 
current n, increase n by one, and return to step 2
How many random numbers will be used on the average to 
generate one Poisson variate?
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Direct Transformations
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Direct Transformation  

Approach for normal(,):
◼ Generate Zi ~ N(0,1)

Approach for lognormal(,):
◼ Generate X ~ N(,)

Yi = eXi  

Xi =  +  Zi



Convolution Method

Erlang Distribution
◼ An Erlang-K random variable X with parameters (K, ) (1/ is the 

mean, K is the stage number) can be obtained by summing K 
independent exponential random variables each having mean    
1/(K )
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